INTRODUCTION TO EXCEL

LEARNING OUTCOME

You will create and format a basic Excel worksheet.

OBJECTIVES & SKILLS: After you read this chapter, you will be able to:

Introduction to Spreadsheets

OBJECTIVE 1: EXPLORE THE EXCEL WINDOW

- Identify Excel window elements
- Identify columns, rows, and cells
- Navigate in and among worksheets

OBJECTIVE 2: ENTER AND EDIT CELL DATA

- Enter text, use auto fill to complete a sequence
- Enter values, enter a date, clear cell contents

HANDS-ON EXERCISE 1:

Introduction to Spreadsheets

79

Mathematical Operations and Formulas

OBJECTIVE 3: CREATE FORMULAS

- Use cell references in formulas
- Apply the order of operations
- Use semi-selection to create a formula, copy formulas

OBJECTIVE 4: DISPLAY CELL FORMULAS

- Display cell formulas

HANDS-ON EXERCISE 2:

Mathematica and formulas

88

Worksheet Structure and Clipboard Tasks

OBJECTIVE 5: MANAGE COLUMNS AND ROWS

- Insert columns, rows, delete cells, columns, and rows
- Hide a column or row, adjust column width

OBJECTIVE 6: SELECT, MOVE, COPY, AND PASTE DATA

98

Select a range, move a range, copy and paste a range, use paste options and paste special

HANDS-ON EXERCISE 3:

Worksheet structure and clipboard tasks

104

Worksheet Formatting

OBJECTIVE 7: APPLY CELL STYLES, ALIGNMENT, AND FONT OPTIONS

- Apply a cell style, merge and center data
- Change cell alignment, wrap text, increase indent, apply a border

OBJECTIVE 8: APPLY NUMBER FORMATS

- Apply number formats, increase and decrease decimal places

HANDS-ON EXERCISE 4:

Worksheet Formatting

116

Work sheets, page setup, and printing

OBJECTIVE 9: MANAGE WORKSHEETS

- Insert a worksheet, delete a worksheet
- Copy or move a worksheet
- Rename a worksheet
- Group worksheets

OBJECTIVE 10: SELECT PAGE SETUP OPTIONS

- Set page orientation, select scaling options, set margin options
- Create a header or footer, select sheet options

OBJECTIVE 11: PREVIEW AND PRINT A WORKSHEET

- View in print preview, set print options

HANDS-ON EXERCISE 5:

- Work sheets, page setup, and printing

131

CASE STUDY | OK Office Systems

Aleshia Bennett, the general manager at OK Office Systems (OKOS), asked you to calculate the retail price, sale price, and profit analysis for selected items on sale this month. Using markup rates provided by Aleshia, you will calculate the retail price, the amount OKOS charges its customers for the products. You will calculate sale prices based on discount rates between 10% and 30%. Finally, you will calculate the profit margin to determine the percentage of the final sale price over the cost.

After you create the initial pricing spreadsheet, you will be able to change values and see that the formulas update the results automatically. In addition, you will insert data for additional sale items or delete an item based on the manager's decision. After inserting formulas, you will format the data in the worksheet to have a professional appearance.

FILE TO BE SUBMITTED:
e01h5Markup_LastFirst

FIGURE 1.1 Completed OKOS Worksheet

CASE STUDY | OK Office Systems

Starting File

e01h1Markup

File to be Submitted

e01h5Markup_LastFirst
Introduction to Spreadsheets

Organizing, calculating, and evaluating quantitative data are important skills needed today for personal and managerial decision making. You track expenses for your household budget, maintain a savings plan, and determine what amount you can afford for a house or car payment. Retail managers create and analyze their organizations’ annual budgets, sales projections, and inventory records. Charitable organizations track the donations they receive, the distribution of those donations, and overhead expenditures.

You should use a spreadsheet to maintain data and perform calculations. A spreadsheet is an electronic file that contains a grid of columns and rows used to organize related data and to display results of calculations, enabling interpretation of quantitative data for decision making.

Performing calculations using a calculator and entering the results into a ledger can lead to inaccurate values. If an input value is incorrect or needs to be updated, you have to recalculate the results manually, which is time-consuming and can lead to inaccuracies. A spreadsheet makes data entry changes easy. If the formulas are correctly constructed, the results recalculate automatically and accurately, saving time and reducing room for error.

In this section, you will learn how to design spreadsheets. In addition, you will explore the Excel window and learn the name of each window element. Then, you will enter text, values, and dates in a spreadsheet.

Exploring the Excel Window

In Excel, a worksheet is a single spreadsheet that typically contains descriptive labels, numeric values, formulas, functions, and graphical representations of data. A workbook is a collection of one or more related worksheets contained within a single file. By default, new workbooks contain one worksheet. Storing multiple worksheets within one workbook helps organize related data together in one file and enables you to perform calculations among the worksheets within the workbook. For example, you might want to create a budget workbook of 13 worksheets, one for each month to store your personal income and expenses and a final worksheet to calculate totals across the entire year.

Identify Excel Window Elements

Like other Microsoft Office programs, the Excel window contains the Quick Access Toolbar, the title bar, sizing buttons, and the Ribbon. In addition, Excel contains unique elements. Figure 1.2 identifies elements specific to the Excel window, and Table 1.1 lists and describes the Excel window elements.

<table>
<thead>
<tr>
<th>Table 1.1 Excel Elements</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Element</strong></td>
</tr>
<tr>
<td>Name Box</td>
</tr>
<tr>
<td>Cancel</td>
</tr>
<tr>
<td>Enter</td>
</tr>
<tr>
<td>Insert Function</td>
</tr>
<tr>
<td>Formula Bar</td>
</tr>
<tr>
<td>Select All</td>
</tr>
<tr>
<td>Column headings</td>
</tr>
<tr>
<td>Row headings</td>
</tr>
<tr>
<td>Active cell</td>
</tr>
<tr>
<td>Sheet tab</td>
</tr>
<tr>
<td>New sheet navigation</td>
</tr>
<tr>
<td>Status bar</td>
</tr>
<tr>
<td>View controls</td>
</tr>
</tbody>
</table>
Identify Columns, Rows, and Cells

A worksheet contains columns and rows, with each column and row assigned a heading. Columns are assigned alphabetical headings from column A to Z, continuing from AA to AZ, and then from BA to BZ until XFD, which is the last of the possible 16,384 columns. Rows have numeric headings ranging from 1 to 1,048,576. Depending on your screen resolution, you may see more or fewer columns and rows than what are shown in the figures in this book.

The intersection of a column and a row is a cell; a total of more than 17 billion cells are available in a worksheet. Each cell has a unique cell address, identified by first its column letter and then its row number. For example, the cell at the intersection of column C and row 6 is cell C6 (see Figure 1.3). The active cell is the current cell. Excel displays a dark green border around the active cell in the worksheet, and the Name Box shows the location of the active cell, which is C6 in Figure 1.3. The contents of the active cell, or the formula used to calculate the results of the active cell, appear in the Formula Bar. Cell references are useful when referencing data in formulas, or in navigation.

![Figure 1.3 Columns, Rows, and Cells](image)

Navigate in and Among Worksheets

To navigate to a new cell, click or use the arrow keys on the keyboard. When you press Enter, the next cell down in the same column becomes the active cell. If you work in a large worksheet, use the vertical and horizontal scroll bars to display another area of the worksheet and click in the desired cell to make it the active cell. The keyboard contains several keys that can be used in isolation or in combination with other keys to navigate in a worksheet. Table 1.2 lists the keyboard navigation methods. The Go To command is helpful for navigating to a cell that is not visible onscreen.

<table>
<thead>
<tr>
<th>Keystroke</th>
<th>Used to</th>
</tr>
</thead>
<tbody>
<tr>
<td>F2 or Ctrl+G</td>
<td>Display the Go To dialog box to enter any cell address.</td>
</tr>
</tbody>
</table>

To display the contents of another worksheet within the workbook, click the sheet tab at the bottom of the workbook window, above the status bar. After you click a sheet tab, you can then navigate within that worksheet.

Entering and Editing Cell Data

You should plan the structure of a worksheet before you start entering data. Using the OKOS case presented at the beginning of the chapter as an example, use the following steps to plan the worksheet design, enter and format data, and complete the workbook. Refer to Figure 1.1 for the completed workbook.

Plan the Worksheet Design

1. **State the purpose of the worksheet.** The purpose of the OKOS worksheet is to store data about products on sale and to calculate important details, such as the retail price based on markup, the sales price based on a discount rate, and the profit margin.

2. **Decide what outputs are needed to achieve the purpose of the worksheet.** Outputs are the results you need to calculate. For the OKOS worksheet, the outputs include columns to calculate the retail price (i.e., the selling price to your customers), the sale price, and the profit margin. In some worksheets, you might want to create an output area, the region in the worksheet to contain formulas dependent on the values in the input area.

3. **Decide what input values are needed to achieve the desired output.** Input values are the initial values, such as variables and assumptions. You may change these values to see what type of effects different values have on the end results. For the OKOS worksheet, the input values include the costs OKOS pays the manufacturers, the markup rates, and the proposed discount rates for the sale. In some worksheets, you should create an input area at the top of the worksheet to change the values in one location rather than in several locations.
Enter and Format the Data

4. Enter the labels, values, and formulas in Excel. Use the design plan (steps 2–3) as you enter labels, input values, and formulas to calculate the output. In the OKOS worksheet, descriptive labels (the product names) appear in the first column to indicate that the values on a specific row pertain to a specific product. Descriptive labels appear at the top of each column, such as Cost and Retail Price, to describe the values in the respective column. Change the input values to test that your formulas produce correct results. If necessary, correct any errors in the formulas to produce correct results. For the OKOS worksheet, change some of the original costs and markup rates to ensure the calculated retail price, selling price, and profit margins percentage results update correctly.

5. Format the numerical values in the worksheet. Align decimal points in columns of numbers and add number formats and styles. In the OKOS worksheet, you will use Accounting Number Format and the Percent Style to format the numerical data. Adjust the number of decimal places as needed.

6. Format the descriptive titles and labels. Add bold and color to headings so that they stand out and are attractive. Apply other formatting to headings and descriptive labels. In the OKOS worksheet, you will center the main title over all the columns, bold and center column labels over the columns, and apply other formatting to the headings.

Complete the Workbook

7. Document the workbook as thoroughly as possible. Include the current date, your name as the workbook author, assumptions, and purpose of the workbook. Some people provide this documentation in a separate worksheet within the workbook. You can also add some documentation in the Properties section when you click the File tab.

8. Save and share the completed workbook. Preview and prepare printouts for distribution in meetings, send an electronic copy of the workbook to those who need it, or upload the workbook on a shared network drive or in the cloud.

Enter Text

STEP 1

Text is any combination of letters, numbers, symbols, and spaces not used in calculations. Excel treats phone numbers, such as 555-1234, and Social Security numbers, such as 123-45-6789, as text entries. You enter text for a worksheet title to describe the contents of the worksheet, as row and column labels to describe data, and as cell data. In Figure 1.4, the cells in column A contain text, such as Class. Text aligns at the left cell margin by default.

To enter text in a cell, complete the following steps:

1. Make sure the cell is active where you want to enter text.
2. Type the text. If you want to enter a numeric value as text, such as a class section number, type an apostrophe and the number, such as ’002.
3. Make another cell the active cell after entering data by completing one of the following steps:
   • Press Enter on the keyboard.
   • Press an arrow key on the keyboard.
   • Press Tab on the keyboard.

Keep the current cell active after entering data by completing one of the following steps:

• Press Ctrl+Enter on the keyboard.
• Click Enter (the check mark between the Name Box and the Formula Bar).

Use Auto Fill to Complete a Sequence

While AutoComplete helps to complete a label that is identical to another label in the same column, Auto Fill is a feature that helps you complete a sequence of words or values. For example, if you enter January in a cell, use Auto Fill to fill in the rest of the months in adjacent cells so that you do not have to type the rest of the month names. Auto Fill can help you complete other sequences, such as quarters (Qtr 1, etc.), weekdays, and weekday abbreviations after you type the first item in the sequence. Figure 1.5 shows the results of filling in months, abbreviated months, quarters, weekdays, abbreviated weekdays, and increments of 5.
To use Auto Fill to complete a series of text (such as month names), complete the following steps:

1. Type the first label (e.g., January) in the starting cell (e.g., cell A1) and press Ctrl+Enter to keep that cell the active cell.
2. Point to the fill handle (a small green square in the bottom-right corner of the active cell) until the pointer changes to a thin black plus sign.
3. Drag the fill handle to repeat the content in other cells (e.g., through cell A12).

Immediately after you use Auto Fill, Excel displays Auto Fill Options in the bottom-right corner of the filled data (refer to Figure 1.5). Click Auto Fill Options to display several fill options: Copy Cells, Fill Series, Fill Formatting Only, Fill Without Formatting, or Flash Fill. The menu will also include other options, depending on the cell content: Fill Months for completing months; Fill Weekdays for completing weekdays; and Fill Days. Fill Weekdays, Fill Months, Fill Years to complete dates. Select Fill Formatting Only when you want to copy the formats but not complete a sequence. Select Fill Without Formatting when you want to complete the sequence but do not want to format the rest of the sequence.

To use Auto Fill to fill a sequence of consecutive numbers (such as 1, 2, 3, etc.), complete the following steps:

1. Type the first number in the starting cell (e.g., cell F1) and press Ctrl+Enter to keep that cell the active cell.
2. Drag the fill handle to fill the content in other cells. Excel will copy the same number for the sequential order, starting with the original value you typed.

For non-consecutive numeric sequences, you must specify the first two values in sequence. For example, if you want to fill in 5, 10, 15, and so on, you must enter 5 and 10 in two adjacent cells before using Auto Fill so that Excel knows to increment by 5.

TIP: FLASH FILL
Flash Fill is a similar feature to Auto Fill in that it can quickly fill in data for you; however, Flash Fill uses data in previous columns as you type in a new label in an adjoining column to determine what to fill in. For example, assume that column A contains a list of first and last names (such as Penny Sumpter in cell A5), but you want to have a column of just first names. To do this, type a name in cell B5, click Fill in the Editing group on the Home tab and select Flash Fill to fill in the rest of column B with people’s first names based on the data entered in column A.

Enter Values

Values are numbers that represent a quantity or a measurable amount. Excel usually distinguishes between text and value data based on what you enter. The primary difference between text and value entries is that value entries can be the basis of calculations, whereas text cannot. In Figure 1.3, the data below the Cost, Markup Rates, and Percent Off labels are values. Values align at the right cell margin by default. After entering values, align decimal places and apply formatting by adding characters, such as $ or %. Entering values is the same process as entering text: Type the value in a cell and click Enter or press Enter.

TIP: ENTERING VALUES WITH TRAILING ZEROS OR PERCENTAGES
You do not need to type the last 0 in 475.50 shown in cell C6 in Figure 1.3. Excel will remove or add the trailing 0 depending on the decimal place formatting. Similarly, you do not have to type the leading 0 in a percentage before the decimal point. Type a percent in the decimal format, such as .5 for 50%.

Enter Dates and Times

You can enter dates and times in a variety of formats. You should enter a static date to document when you create or modify a workbook or to document the specific time when the data were accurate, such as on a balance sheet or income statement. Later, you will learn how to use formulas to enter dates that update to the current date. In Figure 1.6, the data in column A contains the date 9/1/2018 but in different formats. Dates are values, so they align at the right side of a cell. The data in column C contains the time 2:30 PM but in different formats.

FIGURE 1.6 Date and Time Examples
Excel displays dates differently from the way it stores dates. For example, the displayed date 9/1/2018 represents the first day in September in the year 2018. Excel stores dates as serial numbers starting at 1 with January 1, 1900, so that you can create formulas, such as to calculate how many days exist between two dates. For example, 9/1/2018 is stored as 43344.

**Edit and Clear Cell Contents**

After entering data in a cell, you may need to change it. For example, you may want to edit a label to make it more descriptive, such as changing a label from OKC Office Systems Information to OKC Office Systems Pricing Information. Furthermore, you might realize a digit is missing from a value and need to change 500 to 5000.

**To edit the contents of a cell, complete the following steps:**

1. Click the cell.
2. Click in the Formula Bar or press F2 to put the cell in edit mode. The insertion point displays on the right side of the data in the cell when you press F2.
3. Make the changes to the content in the cell.
4. Click or press Enter.

You may want to clear or delete the contents in a cell if you no longer need data in a cell.

**To clear the contents of a cell, complete the following steps:**

1. Click the cell.
2. Press Delete or click the cell and click Clear in the Editing group on the Home tab. and select the desired option (see Figure 1.7).

![FIGURE 1.7 Clear Options](Image)

**Quick Concepts**

1. What are two major advantages of using an electronic spreadsheet instead of a paper-based ledger? p. 70
2. What are the visual indicators that a cell is the active cell? p. 72
3. What steps should you perform before entering data into a worksheet? pp. 73-74
4. What three types of content can you enter into a cell? Give an example (different from those in the book) for each type. pp. 74-77

---

**Hands-On Exercises**

**Skills covered:** Enter Text • Use Auto Fill to Complete a Sequence • Enter Values • Enter a Date • Clear Cell Contents

**1 Introduction to Spreadsheets**

As the assistant manager of OKOS, you will create a worksheet that shows the cost (the amount OKOS pays its suppliers), the markup percentage (the amount by which the cost is increased), and the retail selling price. You will also list the discount percentage (such as 25% off) for each product, the sale price, and the profit margin percentage.

**STEP 1 Enter Text**

Now that you have planned the OKOS worksheet, you are ready to enter labels for the product names in the first column. Refer to Figure 1.8 as you complete Step 1.

![FIGURE 1.8 Text Entered in Cells](Image)

**Troubleshooting:** If you make any major mistakes in this exercise, you can close the file, open e01h1Markup again, and then start this exercise over.

a. Open e01h1Markup and save it as e01h1Markup_LastFirst.
   When you save files, use your last and first names. For example, as the Excel author, I would save my workbook as e01h1Markup_MulberryKeith.

b. Click cell A5, type Computer System, and then press Enter.
   When you press Enter, the next cell down—cell A6 in this case—becomes the active cell. The text does not completely fit in cell A5, and some of the text appears in cell B5. If you make cell B5 the active cell, the Formula Bar is empty, indicating that nothing is stored in that cell.

c. Type Color Laser Printer in cell A6 and press Enter.
   When you start typing C in cell A6, AutoComplete displays a ScreenTip suggesting a previous text entry starting with C—Computer System—but keep typing to enter Color Laser Printer instead.

d. Continue typing the rest of the text in cells A7 through A10 as shown in Figure 1.8.
   Text in column A appears to flow into column B.
   You just entered the product labels to describe the data in each row.
TROUBLESHOOTING: If you make an error, click in the cell containing the error and retype the label, or press F2 to edit the cell contents, move the insertion point using the arrow keys, press Backspace or Delete to delete the incorrect characters, type the correct characters, and press Enter. If you type a label in an incorrect cell, click the cell and press Delete.

e. Click Save on the Quick Access Toolbar to save the changes you made to the workbook. You should develop a habit of saving periodically. That way if your system unexpectedly shuts down, you will not lose everything you worked on.

**STEP 2 >> USE AUTO FILL TO COMPLETE A SEQUENCE**

You want to assign a product code for each product on sale. You will assign consecutive numbers 101 to 106. After typing the first code number, you will use Auto Fill to complete the rest of the series. Refer to Figures 1.9 and 1.10 as you complete Step 2.

![FIGURE 1.9 Auto Fill Copied Original Value](image)

![FIGURE 1.10 Auto Fill Sequence](image)

a. Click cell B5, type 101, and then press Ctrl+Enter.

   The product name Computer System no longer overlaps into column B after you enter data into cell B5. The data in cell A5 is not deleted; the rest of the label is hidden until you increase the column width later.

b. Position the pointer on the fill handle in the bottom-right corner of cell B5.

   The pointer looks like a black plus sign when you point to a fill handle.

c. Double-click the cell B6 fill handle.

   Excel copies 101 as the item number for the rest of the products. Excel stops inserting item numbers in column B when it detects the last label in cell A10 (refer to Figure 1.9).

d. Click Auto Fill Options and select Fill Series. Save the workbook.

   Excel changes the duplicate values to continue sequentially in a series of numbers.

**STEP 3 >> ENTER VALUES**

Now that you have entered the descriptive labels and item numbers, you will enter the cost and markup rate for each product. Refer to Figure 1.11 as you complete Step 3.

![FIGURE 1.11 Values Entered in Cells](image)

a. Click cell C5, type 400, and then press Enter.

b. Type the remaining costs in cells C6 through C10 shown in Figure 1.11.

   To improve your productivity, use the number keypad (if available) on the right side of your keyboard. It is much faster to type values and press Enter on the number keypad rather than to use the numbers on the keyboard. Make sure Num Lock is active before using the number keypad to enter values.

c. Click cell D5, type 0.5, and then press Enter.

   You entered the markup rate as a decimal instead of a percentage. You will apply Percent Style later, but now you will concentrate on data entry.

d. Type the remaining values in cells D6 through D10 as shown in Figure 1.11. Save the workbook.
**Mathematical Operations and Formulas**

A *formula* combines cell references, arithmetic operations, values, and/or functions used in a calculation. Formulas transform static numbers into meaningful results that update as values change. For example, a payroll manager can build formulas to calculate the gross pay, deductions, and net pay for an organization's employees, or a doctoral student can create formulas to perform various statistical calculations to interpret his or her research data.

In this section, you will learn how to use mathematical operations in Excel formulas. You will refresh your memory of the mathematical order of operations and learn how to construct formulas using cell addresses so that when the values of an input cell changes, the result of the formula changes without you having to modify the formula.

**Creating Formulas**

Use formulas to help you analyze how results will change as the input data changes. You can change the value of your assumptions or inputs and explore the results quickly and accurately. For example, if your rent increases, how does that affect your personal budget? Analyzing different input values in Excel is easy after you build formulas. Simply change an input value and observe the change in the formula results. In the OKOSA product sales worksheet, the results for the Retail Price, Sale Price, and Profit Margin labels were calculated by using formulas (refer to Figure 1.1).

**Use Cell References in Formulas**

You should use cell references instead of values in formulas where possible. You may include values in an input area—such as dates, salary, or costs—that you will need to reference in formulas. Referencing these cells in your formulas, instead of typing the value of the cell to which you are referring, keeps your formulas accurate if you change values to perform a what-if analysis.

Figure 1.13 shows a worksheet containing input values and results of formulas. The figure also displays the actual formulas used to generate the calculated results. For example, cell E2 contains the formula =B2+B3. Excel uses the value stored in cell B2 (10) and adds it to the value stored in cell B3 (2). The result (12) appears in cell E2 instead of the actual formula. The Formula Bar displays the formula entered into the active cell.

---

**Figure 1.12 Date Entered in a Cell**

- **a.** Click cell A2, type 9/1, and then press Enter.
  
  The date aligns on the right cell margin by default. Excel displays 1-Sep instead of 9/1.

- **b.** Click cell A2, click Clear in the Editing group on the Home tab, and then select Clear All.
  
  The Clear All command clears both cell contents and formatting in the selected cell(s).

- **c.** Type 9/1/2018 in cell A2 and press Ctrl+Enter.
  
  **TROUBLESHOOTING:** If you did not use Clear All and typed 9/1/2018 in cell A2, Excel would have retained the previous date format and displayed 1-Sep again.

- **d.** Save the workbook. Keep the workbook open if you plan to continue with the next Hands-On Exercise. If not, close the workbook, and exit Excel.
To enter a formula, complete the following steps:
1. Click the cell.
2. Type an equal sign (=), followed by the arithmetic expression, using cell references instead of values. Do not include any spaces in the formula.
3. Click Enter or press Enter.

**TIP: EQUAL SIGN NEEDED**
If you type B2+D3 without the equal sign, Excel does not recognize that you entered a formula and stores the "formula" as text.

**TIP: UPPER OR LOWERCASE**
When you create a formula, type the cell references in uppercase, such as =B2+B3, or lowercase, such as =b2+b3. Excel changes cell references to uppercase automatically.

In Figure 1.13, cell B2 contains 10, and cell B3 contains 2. Cell E2 contains =B2+B3 but shows the result 12. If you change the value of cell B3 to 5, cell E2 displays the new result, which is 15. However, if you had typed actual values in the formula, =10+5, you would have to edit the formula to =10+5, even though the value in cell B3 was changed to 5. Using values in formulas can cause problems as you might forget to edit the formula or you might have a typographical error if you edit the formula. Always design worksheets in such a way as to be able to place those values that might need to change as input values. Referencing cells with input values in formulas instead of using the values themselves will avoid having to modify your formulas if an input value changes later.

**TIP: WHEN TO USE A VALUE IN A FORMULA**
Use cell references instead of actual values in formulas, unless the value will never change. For example, if you want to calculate how many total months are in a specified number of years, enter a formula such as =B5*12, where B5 contains the number of years. You might want to change the number of years, so you type that value in cell B5. However, every year always has 12 months, so you can use the value 12 in the formula.

### Apply the Order of Operations

The order of operations (also called order of precedence) are rules that control the sequence in which arithmetic operations are performed, which affects the result of the calculation. Excel performs mathematical calculations left to right in this order: Parentheses, Exponentiation, Multiplication or Division, and finally Addition or Subtraction. Some people remember the order of operations with the phrase Please Excuse My Dear Aunt Sally.

Table 1.3 lists the primary order of operations. Use Help to learn about the complete order of precedence.

<table>
<thead>
<tr>
<th>Table 1.3 Order of Operations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Order</td>
</tr>
<tr>
<td>-------</td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td>2</td>
</tr>
<tr>
<td>3</td>
</tr>
<tr>
<td>4</td>
</tr>
</tbody>
</table>

**TIP: PARENTHESES IN FORMULAS**
Use parentheses to make sure a lower-order operation occurs first. For example, if you want to add the values stored in cells A1 and A2 and multiply that result by the value stored in cell A3, you would first add A1+A2, multiply the result by A3, and store that result in cell A4. Without parentheses, *A1+A2*A3, the first calculation multiplies the values stored in A2 and A3. That result is then added to the value stored in cell A1 since multiplication has a higher order of operations than addition.

Figure 1.14 shows formulas, the sequence in which calculations occur, calculations, the description, and the results of each order of operations. The highlighted results are the final formula results. This figure illustrates the importance of symbols and use of parentheses.

![Formula Results Based on Order of Operations](Image)

**Use Semi-Selection to Create a Formula**

To decrease typing time and ensure accuracy, use semi-selection. A process of selecting a cell or range of cells for entering cell references as you create formulas. Semi-selection often called pointing because you use the pointer to select cells as you build the formula. Some people prefer using the semi-selection method instead of typing a formula so they can make sure they use the correct cell references as they build the formula.

To use the semi-selection technique to create a formula, complete the following steps:

1. Click the cell where you want to create the formula.
2. Type an equal sign (=) to start a formula.
3. Click the cell that contains the value to use in the formula. A moving marquee appears around the cell or range you select, and Excel displays the cell or range reference in the formula.
4. Type a mathematical operator.
5. Continue clicking cells, selecting ranges, and typing operators to finish the formula.
6. Press Enter to complete the formula.
Copy Formulas

After you enter a formula in a cell, you duplicate the formula without retyping the formula for other cells that need a similar formula. Previously, you learned about the Auto Fill feature that enables you to use the fill handle to fill in a series of values, months, quarters, and weekdays. You can also use the fill handle to copy the formula in the active cell to adjacent cells down a column or across a row, depending on how the data are organized. Cell references in copied formulas adjust based on their relative locations to the original formula.

To copy a formula to other cells using the fill handle, complete the following steps:
1. Click the cell with the content you want to copy to make it the active cell.
2. Point to the fill handle in the bottom-right corner of the cell until the pointer changes to the fill pointer (a thin black plus sign).
3. Drag the fill handle to copy the formula.

Displaying Cell Formulas

Excel shows the result of the formula in the cell (see the top half of Figure 1.15); however, you might want to display the formulas instead of the calculated results in the cells (see the bottom half of Figure 1.15). Displaying the cell formulas may help you double-check all your formulas at one time or troubleshoot a problem with a formula instead of clicking in each cell containing a formula and looking at just the Formula Bar.

To display cell formulas in the worksheet, complete one of the following steps:
• Press Ctrl and the grave accent (`) key, sometimes referred to as the tilde key, in the top-left corner of the keyboard, below the Esc key.
• Click Show Formulas in the Formula Auditing group on the Formulas tab.

To hide the formulas and display the formula results again, repeat the preceding process.
2 Mathematical Operations and Formulas

In Hands-On Exercise 1, you created the basic worksheet for OKOS by entering text, values, and a date for items on sale. Now you will insert formulas to calculate the missing results—specifically, the retail (before sale) price, sale price, and profit margin. You will use cell addresses in your formulas, so when you change a referenced value, the formula results will update automatically.

**STEP 1 USE CELL REFERENCES IN A FORMULA AND APPLY THE ORDER OF OPERATIONS**

The first formula you create will calculate the retail price. The retail price is the price you originally charge. It is based on a percentage of the original cost so that you earn a profit. Refer to Figure 1.16 as you complete Step 1.

**FIGURE 1.16 Retail Price Formula**

a. Open e01h1Markup_LastFirst if you closed it at the end of Hands-On Exercise 1 and save it as e01h2Markup_LastFirst, changing h1 to h2.

b. Click cell E5.

Cell E5 is the cell where you will enter the formula to calculate the retail selling price of the first item.

c. Type =C5*(1+D5) and view the formula and the colored cells and borders on the screen.

As you build or edit a formula, each cell address in the formula displays in a specific color, and while you type or edit the formula, the cells referenced in the formula have a temporary colored border. For example, in the formula =C5*(1+D5), C5 appears in blue, and D5 appears in red. Cell C5 has a temporarily blue border and light blue shading, and cell D5 has a temporarily red border with light red shading to help you identify cells as you construct your formulas (refer to Figure 1.16).

You enclosed 1+D5 in parentheses to control the order of operations so that 1 is added to the value in cell D5 (0.5). The result is 1.5, which represents 150% of the cost. That result is then multiplied by the value in C5 (400). If you did not use the parentheses, Excel would multiply the value in C5 by 1 (which would be 400) and add that result to the value in D5 (0.5) for a final result of 400.5, which would have given you incorrect results.

An alternative formula also calculates the correct retail price: =C5*D5+C5 or =C5*(1+D5). In this formula, 400 (cell C5) is multiplied by 0.5 (cell D5); that result (200) represents the dollar value of the markup. Excel adds the value 200 to the original cost of 400 to obtain 600, the retail price. You were instructed to enter =C5*(1+D5) to demonstrate the order of operations.

d. Click Enter (Enter) (between the Name Box and the Formula Bar) and view the formula in the Formula Bar to check its accuracy. The result of the formula, 600, appears in cell E5, and the formula displays in the Formula Bar. This formula first adds 1 (the decimal equivalent of 100%) to 0.5 (the value stored in cell D5). Excel multiplies that sum of 1.5 by 400 (the value stored in cell C5). This calculation reflects a retail price of 150% of the original cost.

**TROUBLESHOOTING:** If the result is not correct, click the cell and look at the formula in the Formula Bar. Click in the Formula Bar; edit the formula to match the formula shown in Step c, and click Enter (the check mark between the Name Box and the Formula Bar). Make sure you start the formula with an equal sign.

e. Position the pointer on the cell E5 fill handle. When the pointer changes from a white plus sign to a thin black plus sign, double-click the fill handle.

Excel copies the retail price formula for the remaining products in your worksheet. Excel detects when to stop copying the formula when it detects the last label in the dataset.

f. Click cell E6, the cell containing the first copied retail price formula, look at the Formula Bar, and then save the workbook.

The formula in cell E6 is =C6*(1+D6). It was copied from the formula in cell E5, which is =C5*(1+D5). Excel adjusts the row references in this formula as you copied the formula down a column so that the results are based on each row’s data.

**TROUBLESHOOTING:** The result in cell E7 may show more decimal places than shown in Figure 1.16. Do not worry about this slight difference.

**STEP 2 USE SEMI-SELECTION AND APPLY THE ORDER OF OPERATIONS TO CREATE A FORMULA**

Now that you have calculated the retail price, you will calculate a sale price. This week, the computer is on sale for 15% off the retail price. Refer to Figure 1.17 as you complete Step 2.

**FIGURE 1.17 Sale Price Formula**
a. Click cell G5, the cell where you will enter the formula to calculate the sale price.
b. Type =, click cell E5, type -, click cell E5, type *, and then click cell F5. Notice the color-coding in the cell addresses. Press Ctrl+Enter to keep the current cell the active cell.

You used the semi-selection method to enter a formula. The result is 510. Looking at the formula, you might think E5*E5 equals zero; remember that because of the order of operations, multiplication is calculated before subtraction. The product of 600 (cell E5) and 0.15 (cell F5) equals 90, which is then subtracted from 600 (cell E5), so the sale price is 510.

TROUBLESHOOTING: You should check the result for logic. Use a calculator to spot-check the accuracy of formulas. If you mark down merchandise by 15% of its regular price, you are charging 85% of the regular price. You should spot-check your formula to ensure that 85% of 600 is 510 by multiplying 600 by 0.85.

c. Click cell G5, type =E5-(E5*F5), and then click Enter.

Although the parentheses are not needed because the multiplication occurs before the subtraction, it may be helpful to add parentheses to make the formula easier to interpret.

d. Double-click the cell G5 fill handle to copy the formula down column G.

e. Click cell G6, the cell containing the first copied sale price formula, view the Formula Bar, and save the workbook.

The original formula was =E5-(E5*F5). The copied formula in cell G6 is adjusted to =E6-(E6*F6) so that it calculates the sales price based on the data in row 6.

**STEP 3 **USE CELL REFERENCES IN A FORMULA AND APPLY THE ORDER OF OPERATIONS

After calculating the sale price, you want to know the profit margin OKOS will earn. OKOS paid $400 for the computer and will sell it for $510. The profit of $110 is then divided by the $400 cost, which gives OKOS a profit margin of 0.275686, which will be formatted later as a percent 21.6%. Refer to Figure 1.18 as you complete Step 3.

![Figure 1.18 Profit Margin Formula](image)

**FIGURE 1.18 Profit Margin Formula**

STEP 4 DISPLAY CELL FORMULAS

You want to see how the prices and profit margins are affected when you change some of the original cost values. For example, the supplier might notify you that the cost to you will increase. In addition, you want to see the formulas displayed in the cells temporarily. Refer to Figures 1.19 and 1.20 as you complete Step 4.

![Figure 1.19 Results of Changed Values](image)

**FIGURE 1.19 Results of Changed Values**

![Figure 1.20 Formulas Displayed in the Worksheet](image)

**FIGURE 1.20 Formulas Displayed in the Worksheet**

a. Click cell H5, the cell where you will enter the formula to calculate the profit margin.

The profit margin is the profit (difference in sales price and cost) percentage of the sale price.

b. Type =(G5-C5)/G5 and notice the color-coding in the cell addresses. Press Ctrl+Enter.

The formula must first calculate the profit, which is the difference between the sale price (510) and the original cost (400). The difference (110) is then divided by the sale price (510) to determine the profit margin of 0.215686, or 21.6%.

c. Double-click the cell H5 fill handle to copy the formula down the column.

d. Click cell H6, the cell containing the first copied profit margin formula, look at the Formula Bar, and then save the workbook.

The original formula was =(G5-C5)/G5, and the copied formula in cell H6 is =(G6-C6)/G6.
c. Click cell F7, type 0.05, and then press Ctrl+Enter.
   
   The results of the sale price and profit margin formulas change based on the new markdown rate. Note that the retail price did not change because that formula is not based on the markdown rate.

d. Press Ctrl+` (the grave accent mark).
   
   The workbook now displays the formulas rather than the formula results (refer to Figure 1.20). This is helpful when you want to review several formulas at one time. Numbers are left-aligned, and the date displays as a serial number when you display formulas.

e. Press Ctrl+` (the grave accent mark).
   
   The workbook now displays the formula results in the cells again.

f. Save the workbook. Keep the workbook open if you plan to continue with the next Hands-On Exercise. If not, close the workbook, and exit Excel.

---

Worksheet Structure and Clipboard Tasks

Although you plan worksheets before entering data, you might need to insert a new row to accommodate new data. Delete a column that you no longer need, hide a column of confidential data before printing worksheets for distribution, or adjust the size of columns and rows so that the data fit better. Furthermore, you may decide to move data to a different location in the same worksheet or even to a different worksheet. Instead of deleting the original data and typing it in the new location, select and move data from one cell to another. In some instances, you might want to create a copy of data entered so that you can explore different values and compare the results of the original data set and the copied and edited data set.

In this section, you will learn how to make changes to columns and rows. Furthermore, you will also learn how to select ranges, move data to another location, copy data to another range, and use the Paste Special feature.

Managing Columns and Rows

As you enter and edit worksheet data, you might need to adjust the row and column structure to accommodate new data or remove unnecessary data. You can add rows and columns to add new data and delete data, columns, and rows that you no longer need. Adjusting the height and width of rows and columns, respectively, can often present the data better.

Insert Cells, Columns, and Rows

After you construct a worksheet, you might need to insert cells, columns, or rows to accommodate new data. For example, you might want to insert a new column to perform calculations or insert a new row to list a new product.

To insert a new column or row, complete the following steps:

1. Click in the column or row.
2. Click the Insert arrow in the Cells group on the Home tab (see Figure 1.21).
3. Select Insert Cell Columns or Insert Sheet Rows.

---

STEP 1

---

FIGURE 1.21 Insert Menu

Alternatively, you can use a shortcut menu. Right-click the column (letter) or row (number) heading. Then select Insert from the shortcut menu.

Excel inserts new columns to the left of the current column and new rows above the active row. If the current column is column C and you insert a new column, the new column becomes column D, and the original column C data are now in column B. Likewise.
if the current row is 5 and you insert a new row, the new row is row 6, and the original row 5 data are now in row 6. When you insert cells, rows, and columns, cell addresses in formulas adjust automatically.

Inserting a cell is helpful when you realize that you left out an entry after you have entered all of the data. Instead of inserting a new row or column, you just want to move the existing content down or over to enter the missing value. You can insert a single cell in a particular row or column.

**To insert one or more cells, complete the following steps:**

1. Click in the cell where you want the new cell.
2. Click the Insert arrow in the Cells group on the Home tab.
3. Select Insert Cells.
4. Select an option from the Insert dialog box (see Figure 1.22) to position the new cell and click OK.

![FIGURE 1.22 Insert Dialog Box](image)

Alternatively, click Insert in the Cells group. The default action of clicking Insert is to insert a cell at the current location, which moves existing data down in that column only.

**Delete Cells, Columns, and Rows**

If you no longer need a cell, column, or row, you should delete it. For example, you might want to delete a row containing a product you no longer carry. In these situations, you are deleting the entire cell, column, or row, not just the contents of the cell to leave empty cells. As with inserting new cells, columns, or rows, any affected formulas adjust the cell references automatically.

**To delete a column or row, complete the following steps:**

1. Click the column or row heading for the column or row you want to delete.
2. Click Delete in the Cells group on the Home tab.

Alternatively, click in any cell within the column or row you want to delete, click the Delete arrow in the Cells group on the Home tab (see Figure 1.23), and then select Delete Sheet Columns or Delete Sheet Rows. Another alternative is to right-click the column letter or row number for the column or row you want to delete and then select Delete from the shortcut menu.

**FIGURE 1.23 Delete Menu**

**To delete a cell or cells, complete the following steps:**

1. Select the cell(s).
2. Click the Delete arrow in the Cells group.
3. Select Delete Cells to display the Delete dialog box (see Figure 1.24).
4. Click the appropriate option to shift cells left or up and click OK.

![FIGURE 1.24 Delete Dialog Box](image)

Alternatively, click Delete in the Cells group. The default action of clicking Delete is to delete the active cell, which moves existing data up in that column only.

**Hide and Unhide Columns and Rows**

If your worksheet contains information you do not want to display, hide some columns and/or rows before you print a copy for public distribution. However, the column or row is not deleted. If you hide column B, you will see columns A and C side by side. If you hide row 3, you will see rows 2 and 4 together. Figure 1.25 shows that column B and row 3 are hidden. Excel displays a double line between column headings (such as between A and C), indicating one or more columns are hidden, and a double line between row headings (such as between 2 and 4), indicating one or more rows are hidden.

![FIGURE 1.25 Hidden Columns and Rows](image)
To hide a column or row, complete one of the following steps:
1. Select a cell or cells in the column or row you want to hide.
2. Click Format in the Cells group on the Home tab (refer to Figure 1.26), then Point to Hide & Unhide.
3. Select Hide Columns or Hide Rows, depending on what you want to hide.

Alternatively, you can right-click the column or row heading(s) you want to hide. Then select Hide.

You can hide multiple columns and rows at the same time. To select adjacent columns (such as columns B through E) or adjacent rows (such as rows 2 through 4), drag across the adjacent column or row headings and use the Hide command.

To hide nonadjacent columns or rows, complete the following steps:
1. Press and hold Ctrl while you click the desired column or row headings.
2. Use any acceptable method to hide the selected columns or rows.

To unhide a column or row, complete the following steps:
1. Select the columns or rows on both sides of the hidden column or row. For example, if column B is hidden, drag across column letters A and C.
2. Click Format in the Cells group on the Home tab (refer to Figure 1.26), point to Hide & Unhide, and select Unhide Columns or Unhide Rows, depending on what you want to display again.

**TIP: UNHIDING COLUMN A, ROW 1, AND ALL HIDDEN ROWS/COLUMNS**
Unhiding column A or row 1 is different because you cannot select the row or column on either side. To unhide column A or row 1, type A1 in the Name Box and press Enter. Click Format in the Cells group on the Home tab, point to Hide & Unhide, and select Unhide Columns or Unhide Rows to display column A or row 1, respectively. If you want to unhide all columns and rows, click Select All (the triangle above the row 1 heading and to the left of the column A heading) and use the Hide & Unhide submenu.

---

**Adjust Column Width**
After you enter data in a column, you often need to adjust the column width—the horizontal measurement of a column in a table or a worksheet. In Excel, column width is measured by the number of characters or pixels. For example, in the worksheet you created in Hands-On Exercises 1 and 2, the labels in column A displayed into column B when those adjacent cells were empty. However, after you typed values in column B, the labels in column A appeared cut off. You will need to widen column A to show the full name of all your products.

**TIP: POUND SIGNS DISPLAYED**
Numbers and dates appear as a series of pound signs (#) when the cell is too narrow to display the complete value, and text appears to be truncated.

To widen a column to accommodate the longest label or value in a column, complete one of the following sets of steps:
- **Point to the right vertical border of the column heading.** When the pointer displays as a two-headed arrow, double-click the border. For example, if column B is too narrow to display the content in that column, double-click the right vertical border of the column B heading.
- **Click Format in the Cells group on the Home tab (refer to Figure 1.26) and select AutoFit Column Width.**

To adjust the width of a column to an exact width, complete the following sets of steps:
- **Drag the vertical border to the left to decrease the column width or to the right to increase the column width.** As you drag the vertical border, Excel displays a ScreenTip specifying the width (see Figure 1.27) from 0 to 255 characters and in pixels.
- **Click Format in the Cells group on the Home tab (refer to Figure 1.26), select Column Width, type a value that represents the maximum number of characters to display in the Column width box in the Column Width dialog box, and then click OK.**

---

**FiguRE 1.27 Increasing Column Width**

---

*CHAPTER 1: Introduction to Excel*
Adjust Row Height

You can adjust the **row height**—the vertical measurement of the row—in a way similar to how you change column width by double-clicking the border between row numbers or by selecting Row Height or AutoFit Row Height from the Format menu (refer to Figure 1.26). In Excel, row height is a value between 0 and 409 based on point size (abbreviated as pt) and pixels. Whether you are measuring font sizes or row heights, one point size is equal to 1/72 of an inch. Your row height should be taller than your font size. For example, with an 11-pt font size, the default row height is 15.

**TIP: MULTIPLE COLUMN WIDTHS AND ROW HEIGHTS**

You can set the size for more than one column or row at a time to make the selected columns or rows the same size. Drag across the column or row headings for the area you want to format, and set the size using any method.

Selecting, Moving, Copying, and Pasting Data

You may already know the basics of selecting, cutting, copying, and pasting data in other programs, such as Microsoft Word. These tasks are somewhat different when working in Excel.

**Select a Range**

A range refers to a group of adjacent or contiguous cells in a worksheet. A range may be as small as a single cell or as large as the entire worksheet. It may consist of a row or part of a row, a column or part of a column, or multiple rows or columns, but will always be a rectangular shape, as you must select the same number of cells in each row or column for the entire range. A range is specified by indicating the top-left and bottom-right cells in the selection. For example, in Figure 1.28, the date is a single-cell range in cell A2, the Color Laser Printer data are stored in the range A6:H6, the cost values are stored in the range C5:C10, and the sales prices and profit margins are stored in range G5:F10. A **nonadjacent range** contains multiple ranges, such as D5:D10 and F5:F10. At times, you will select nonadjacent ranges so that you can apply the same formatting at the same time, such as formatting the nonadjacent range D5:D10 and F5:F10 with Percent Style.

**TABLE 1.4 Selecting Ranges**

<table>
<thead>
<tr>
<th>To Select:</th>
<th>Do This:</th>
</tr>
</thead>
<tbody>
<tr>
<td>A range</td>
<td>Drag until you select the entire range. Alternatively, click the first cell in the range, press and hold Shift, and click the last cell in the range.</td>
</tr>
<tr>
<td>An entire column</td>
<td>Click the column heading.</td>
</tr>
<tr>
<td>An entire row</td>
<td>Click the row heading.</td>
</tr>
<tr>
<td>Current range containing data, including headings</td>
<td>Click in the range of data and press Ctrl+A.</td>
</tr>
<tr>
<td>All cells in a worksheet</td>
<td>Click Select All or press Ctrl+A twice.</td>
</tr>
<tr>
<td>Nonadjacent range</td>
<td>Select the first range, press and hold Ctrl, and select additional range(s).</td>
</tr>
</tbody>
</table>

A green border appears around a selected range. Any command you execute will affect the entire range. The range remains selected until you select another range or click in any cell in the worksheet.

**TIP: NAME BOX**

Use the Name Box to select a range by clicking in the Name Box, typing a range address such as B15:D25, and pressing Enter.

**Move a Range**

You can move cell contents from one range to another. For example, you might want to move an input area from the right side of the worksheet to above the output range. When you move a range containing text and values, the text and values do not change. However, any formulas that refer to cells in that range will update to reflect the new cell addresses.

**To move a range, complete the following steps:**

1. Select the range.
2. Click Cut in the Clipboard group to copy the range to the Clipboard (see Figure 1.29).
   Unlike cutting data in other Microsoft Office applications, the data you cut in Excel remain in their locations until you paste them elsewhere. A moving dashed green border surrounds the selected range and the status bar displays Select destination and press ENTER or choose Paste.
3. Ensure the destination range—the range where you want to move the data—is the same size or greater than the size of the cut range.
4. Click in the top-left corner of the destination range, and use the Paste command (see Figure 1.29). If any cells within the destination range contain data, Excel overwrites that data when you use the Paste command.

**FIGURE 1.28 Sample Ranges**

**FIGURE 1.29 Cut, Copy, Paste**
Copy and Paste a Range

You may want to copy cell contents from one range to another. When you copy a range, the original data remain in their original locations. For example, you might copy your January budget to another worksheet to use as a model for creating your February budget. Cell references in copied formulas adjust based on their relative locations to the original data. Furthermore, you want to copy formulas from one range to another range. In this situation where you cannot use the fill handle, you will use the Copy and Paste functions to copy the formula.

To copy a range, complete the following steps:

1. Select the range.
2. Click Copy in the Clipboard group (refer to Figure 1.29) to copy the contents of the selected range to the Clipboard. A moving dashed green border surrounds the selected range and the status bar displays Select destination and press ENTER or choose Paste.
3. Ensure the destination range—the range where you want to copy the data—is the same size or greater than the size of the copied range.
4. Click in the top-left corner of the destination range where you want the duplicate data, and click Paste (refer to Figure 1.29). If any cells within the destination range contain data, Excel overwrites that data when you use the Paste command. The original range still has the moving dashed green border, and the pasted copied range is selected with a solid green border. Figure 1.30 shows a selected range (A4:H10) and a copy of the range (I4:Q10). Immediately after you click Paste, the Paste Options button displays in the bottom-right corner of the pasted data. Click the arrow to select a different result for the pasted data.
5. Press Esc to turn off the moving dashed border around the originally selected range.

Use Paste Options and Paste Special

Sometimes you might want to paste data in a different format than they are in the Clipboard. For example, you might want to preserve the results of calculations before changing the original data. To do this, you can paste the data as values. If you want to copy data from Excel and paste them into a Word document, you can paste the Excel data as a worksheet object, as unformatted text, or in another format.

To paste data from the Clipboard into a different format, complete the following steps:

1. Click the Paste arrow in the Clipboard group (see Figure 1.31).
2. Point to command to see a ScreenTip and a preview of how the pasted data will look.
3. Click the option you want to apply.

<table>
<thead>
<tr>
<th>Paste</th>
<th>Paste Special</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy</td>
<td>Paste Special</td>
</tr>
<tr>
<td>Paste</td>
<td>Paste Special</td>
</tr>
<tr>
<td>Paste Options button</td>
<td>Paste Special</td>
</tr>
</tbody>
</table>

**FIGURE 1.31 Paste Options**

Table 1.5 lists and describes some of the options in the Paste gallery that opens when you click the Paste arrow in the Clipboard or the Paste Options button that displays immediately after you use Paste. Paste options enable you to paste content or attributes, such as a formula or format.
TABLE 1.5 Paste Options

<table>
<thead>
<tr>
<th>Icon</th>
<th>Option Name</th>
<th>Paste Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🍀</td>
<td>Paste</td>
<td>Cell contents and all formatting from copied cells</td>
</tr>
<tr>
<td>🍁</td>
<td>Formulas</td>
<td>Formulas, but no formatting, from copied cells</td>
</tr>
<tr>
<td>🍂</td>
<td>Formulas &amp; Number Formatting</td>
<td>Formulas and number formatting, such as Currency, but no font formatting, such as font color, fill color, or borders</td>
</tr>
<tr>
<td>🍃</td>
<td>Keep Source Formatting</td>
<td>Cell contents and formatting from copied cells</td>
</tr>
<tr>
<td>🍄</td>
<td>No Borders</td>
<td>Cell contents, number formatting, and text formatting except borders</td>
</tr>
<tr>
<td>🍅</td>
<td>Keep Source Column Widths</td>
<td>Cell contents, number and text formatting, and the column width of the source data when pasting to another column</td>
</tr>
<tr>
<td>🍆</td>
<td>Transpose</td>
<td>Transposes data from rows to columns and columns to rows</td>
</tr>
<tr>
<td>🍇</td>
<td>Values</td>
<td>Unformatted values that are the results of formulas, not the actual formulas</td>
</tr>
<tr>
<td>🍈</td>
<td>Values &amp; Number Formatting</td>
<td>Values that are the results of formulas, not the actual formulas; preserves number formatting but not text formatting</td>
</tr>
<tr>
<td>🍉</td>
<td>Values &amp; Source Formatting</td>
<td>Values that are the results of formulas, not the actual formulas; preserves number and text formatting</td>
</tr>
<tr>
<td>🍊</td>
<td>Formatting</td>
<td>Number and text formatting only from the copied cells; no call contents</td>
</tr>
<tr>
<td>🍋</td>
<td>Paste Link</td>
<td>Creates a reference to the source cells (such as =H$5*$15), not the call contents; preserves number formatting but not text formatting</td>
</tr>
<tr>
<td>🍌</td>
<td>Picture</td>
<td>Creates a picture image of the copied data; pasted data is not editable</td>
</tr>
<tr>
<td>🍍</td>
<td>Linked Picture</td>
<td>Creates a picture with a reference to the copied cells; if the original cell content changes, so does the picture</td>
</tr>
<tr>
<td>🍎</td>
<td>Paste Special</td>
<td>Opens the Paste Special dialog box (see Figure 1.32)</td>
</tr>
</tbody>
</table>

TIP: TRANSPONDING COLUMNS AND ROWS

After entering data into a worksheet, you might want to transpose the columns and rows so that the data in the first column appears as column labels across the first row, or the column labels in the first row appear in the first column. Figure 1.33 shows the original data with the months in column A and the utility costs in columns B, C, and D. In the transposed data, the months are shown in the first row, and each row contains utility information. The original formats (bold and right-aligned) are copied in the transposed data.

FIGURE 1.33 Transposed Data

Copy Excel Data to Other Programs

You can copy Excel data and use it in other applications, such as in a Word document or in a PowerPoint slide show. For example, you might perform statistical analyses in Excel and copy the data into a research paper in Word. Or, you might want to create a budget in Excel and copy the data into a PowerPoint slide show for a meeting.

After selecting and copying a range in Excel, you must decide how you want the data to appear in the destination application. Click the Paste arrow in the destination application to see a gallery of options or to select the Paste Special option.

8. Give an example of when you would delete a column versus when you would hide a column. **pp. 94-95**
9. When should you adjust column widths instead of using the default widths? **p. 97**
10. Why would you use the Paste Special options in Excel? **p. 101**
Hands-On Exercises

Skills covered: Insert Columns and Rows • Delete a Row • Hide a Column • Adjust Column Width • Adjust Row Height • Select a Range • Move a Range • Copy and Paste a Range • Use Paste Special

3 Worksheet Structure and Clipboard Tasks

You want to insert a column to calculate the amount of markup and delete a row containing data you no longer need. You also want to adjust column widths to display the labels in the columns. In addition, your supervisor asked you to enter data for a new product. Because it is almost identical to an existing product, you will copy the original data and edit the copied data to save time. You also want to experiment with the Paste Special option to see the results of using it in the ORIOS workbook.

**STEP 1 ➔ INSERT A COLUMN AND ROWS**

You decide to add a column to display the amount of profit. Because profits are a dollar amount, you want to keep the profit column close to another column of dollar amounts. Therefore, you will insert the profit column before the profit margin (percentage) column. You will insert new rows for product information and category names. Refer to Figure 1.34 as you complete Step 1.

**FIGURE 1.34 Column and Rows Inserted**

- Open e01h2Markup_LastFirst if you closed it at the end of Hands-On Exercise 2 and save it as e01h3Markup_LastFirst, changing h2 to h3.
- Click cell H5 (or any cell in column H).
- You want to insert a column between the Sale Price and Profit Margin columns so that you can calculate the profit amount in dollars.
- Click the Insert arrow in the Cells group and select Insert Sheet Columns.
- You inserted a new blank column H. The data in the original column H are now in column I.
- Click cell H4, type Profit Amount, and then press Enter.
- Ensure the active cell is cell H5. Type =G5-C5 and click Enter. Double-click the cell H5 fill handle.
- You calculated the profit amount by subtracting the original cost from the sale price and then copied the formula down the column.
- Right-click the row 5 heading and select Insert from the shortcut menu.
- You inserted a new blank row 5, which is selected. The original rows of data move down a row each.

**FIGURE 1.35 Row Deleted and Column Hidden**

- Click cell A9 (or any cell on row 9), the row that contains the Filing Cabinet data.
- Click the Delete arrow in the Cells group and select Delete Sheet Rows.
- The Filing Cabinet row is deleted, and the remaining rows move up one row.

**TROUBLESHOOTING:** If you accidentally delete the wrong row or accidentally selected Delete Sheet Columns instead of Delete Sheet Rows, click Undo on the Quick Access Toolbar to restore the deleted row or column.

- Click the column B heading.
- Click Format in the Cells group, point to Hide & Unhide, and then select Hide Columns.
- Excel hides column B. You see a gap in column heading letters A and C, indicating column B is hidden instead of deleted.
- Save the workbook.
**ADJUST COLUMN WIDTH AND ROW HEIGHT**

As you review your worksheet, you notice that the labels in column A appear cut off. You will increase the width of that column to display the entire product names. In addition, you want to make row 1 taller. Refer to Figure 1.36 as you complete Step 3.

**FIGURE 1.36 Column Width and Row Height Changed**

**a.** Point to the right border of column A. When the pointer looks like a double-headed arrow with a solid black vertical line, double-click the border.

When you double-click the border between two columns, Excel adjusts the width of the column on the left side of the border to fit the contents of that column. Excel increased the width of column A based on the cell containing the longest content (the title in cell A1). You decide to adjust the column width to the longest product name instead.

**b.** Point to the right border of column A until the double-headed arrow appears. Drag the border to the left until the ScreenTip displays **Width: 23.00 (166 pixels)**. Release the mouse button.

You decreased the column width to 23 for column A. The longest product name is visible. You will not adjust the other column widths until after you apply formats to the column headings in Hands-On Exercise 4.

**c.** Click **cell A1**. Click **Format** in the Cells group and select **Row Height**.

The Row Height dialog box opens so that you can adjust the height of the current row.

**d.** Type 30 in the **Row height box** and click **OK**. Save the workbook.

You increased the height of the row that contains the worksheet title so that it is more prominent.

**SELECT A RANGE AND MOVE A RANGE TO A NEW LOCATION**

You want to move the 27" Monitor product to be immediately after the Color Laser Printer product. Before moving the 27" Monitor row, you will insert a blank row between the Color Laser Printer and Furniture rows. Refer to Figure 1.37 as you complete Step 4.

**FIGURE 1.37 Row Moved to New Location**

**a.** Right-click the **row 8 heading** and select **Insert** from the menu.

You will insert a blank row so that you can move the 27" Computer Monitor data to be between the Color Laser Printer and Furniture rows.

**b.** Select the **range A12:E12**.

You selected the range of cells containing the 27" Monitor data.

**c.** Click **Cut** in the Clipboard group.

A moving dashed green border outlines the selected range. The status bar displays the message **Select destination and press ENTER or choose Paste**.

**d.** Click **cell A8**.

This is the first cell in the destination range. If you cut and paste a row without inserting a new row first, Excel will overwrite the original row of data, which is why you inserted a new row in step a.

**e.** Click **Paste** in the Clipboard group and save the workbook.

The 27" Monitor product data is now located on row 8.
Aleshia told you that a new chair is on its way. She asked you to enter the data for the Executive Desk Chair. Because most of the data is the same as the Desk Chair data, you will copy the original Desk Chair data, edit the product name, and change the cost to reflect the cost of the second chair. Refer to Figure 1.38 as you complete Step 5.

**FIGURE 1.38 Data Copied and Edited**

**a.** Select the range A10:E10 and click Copy in the Clipboard group.

You copied the row containing the Desk Chair product data to the Clipboard.

**b.** Click cell A12, click Paste in the Clipboard group, and then press Esc.

The pasted range is selected in row 12.

**c.** Click cell A12, press F2 to activate Edit Mode, press Home, type Executive, press Spacebar, and then press Enter.

You edited the product name to display Executive Desk Chair.

**d.** Change the value in cell C12 to 200. Save the workbook.

The formulas calculate the results based on the new cost of 200 for the Executive Desk Chair.

**FIGURE 1.39 Paste Special Results**

**a.** Click cell A1. Change the font size to 14, click Bold, click the Font Color arrow in the Font group and then select Gold, Accent 4, Darker 50%.

You will format text to see the effects of using different Paste Special options.

**b.** Select the range A11:E12 and click Copy in the Clipboard group.

**c.** Click cell A15, the top-left corner of the destination range.

**d.** Click the Paste arrow in the Clipboard group and point to Formulas, the second icon from the left in the Paste group.

Without clicking the command, Excel shows you a preview of what that option would do. The pasted copy would not contain the font formatting you applied to the title or the bold on the two category names. In addition, the pasted date would appear as a serial number. The formulas would be maintained.

**e.** Position the pointer over Values & Source Formatting, the first icon from the right in the Paste Values group.

This option would preserve the formatting, but it would convert the formulas into the current value results.

**f.** Click Values & Source Formatting, click cell H16 to see a formula, and then click cell H20. Press Esc to turn off the border.

Cell H6 contains a formula, but in the pasted version, the equivalent cell H20 has converted the formula result into an actual value. If you were to change the original cost on row 20, the contents of cell H20 would not change. In a working environment, this is useful only if you want to capture the exact value in a point in time before making changes to the original data.

**g.** Save the workbook. Keep the workbook open if you plan to continue with the next Hands-On Exercise. If not, close the workbook and exit Excel.
Worksheet Formatting

After entering data and formulas, you should format the worksheet. A professionally formatted worksheet—through adding appropriate symbols, aligning decimals, and using fonts and colors to make data stand out—makes finding and analyzing data easy. You apply different formats to accentuate meaningful details or to draw attention to specific ranges in a worksheet.

In this section, you will learn to apply a cell style, different alignment options, including horizontal and vertical alignment, text wrapping, and indent options. In addition, you will learn how to format different types of values.

Applying Cell Styles, Alignment, and Font Options

Different areas of a worksheet should have different formatting. For example, the title may be centered in 16-pt size; column labels may be bold, centered, and Dark Blue font; and input cells may be formatted differently from output cells. You can apply different formats individually, or you can apply a group of formats by selecting a cell style. A cell style is a collection of format settings to provide a consistent appearance within a worksheet and among similar workbooks. A cell style controls the following format: font, font color and font size, borders and fill colors, alignment, and number formatting.

To apply a cell style to a cell or a range of cells, complete the following steps:

1. Click Cell Styles in the Styles group on the Home tab to display the Cell Styles gallery (see Figure 1.40).
2. Position the pointer over a style name to see a Live Preview of how the style will affect the selected cell or range. The gallery provides a variety of built-in styles to apply to your worksheet data.
3. Click a style to apply it to the selected cell or range.

![Figure 1.40 Cell Styles](image)

Alignment refers to how data are positioned in the boundaries of a cell. Each type of data has a default alignment. Text aligns at the left cell margin, and dates and values align at the right cell margin. You should change the alignment of cell contents to improve the appearance of data within the cells. The Alignment group (see Figure 1.41) on the Home tab contains several commands to help you align and format data.

![Alignment Options](image)

TIP: ALIGNMENT OPTIONS

The Format Cells dialog box contains additional alignment options. To open the Format Cells dialog box, click the Dialog Box Launcher in the Alignment group on the Home tab. The Alignment tab in the dialog box contains the options for aligning data.

Merge and Center Labels

You may want to place a title at the top of a worksheet and center it over the columns of data in the worksheet. You can center main titles over all columns in the worksheet, and you can center category titles over related columns. You can also merge cells on adjacent rows.

To merge and center cells, complete the following steps:

1. Enter the text in the top-left cell of the range.
2. Select the range of cells across which you want to center the label.
3. Click Merge & Center in the Alignment group on the Home tab.

Only data in the far left cell (or top-right cell) are merged. Any other data in the merged cells are deleted. Excel merges the selected cells together into one cell, and the merged cell address is that of the original cell on the left. The data are centered within the merged cell.

If you want to split a merged cell into multiple cells, click the merged cell and click Merge & Center. Unmerging places the data in the top-left cell.

![FIGURE 1.41 Alignment and Font Settings Applied](image)
For additional options, click the Merge & Center arrow. Table 1.6 lists the four merge options.

<table>
<thead>
<tr>
<th>TABLE 1.6 Merge Options</th>
<th>Option</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Merge &amp; Center</td>
<td>Merges selected cells and centers data into one cell.</td>
</tr>
<tr>
<td></td>
<td>Merge Across</td>
<td>Merges the selected cells but keeps text left aligned or values right aligned.</td>
</tr>
<tr>
<td></td>
<td>Merge Cells</td>
<td>Merges a range of cells on multiple rows as well as in multiple columns.</td>
</tr>
<tr>
<td></td>
<td>Unmerge Cells</td>
<td>Separates a merged cell into multiple cells again.</td>
</tr>
</tbody>
</table>

**Change Horizontal and Vertical Cell Alignment**

**Horizontal alignment** specifies the position of data between the left and right cell margins, and **vertical alignment** specifies the position of data between the top and bottom cell margins. Bottom Align is the default vertical alignment (as indicated by the light green background on the Ribbon), and Align Left is the default horizontal alignment for text. In Figure 1.41, the labels on row 4 have Center horizontal alignment and the title in row 1 has Middle Align vertical alignment. To change alignments, click the desired alignment setting(s) in the Alignment group on the Home tab.

**TIP: ROTATE CELL DATA**

People sometimes rotate headings in cells. To rotate data in a cell, click Orientation in the Alignment group and select an option, such as Angle Clockwise.

**Wrap Text**

Sometimes you have to maintain specific column widths, but the data do not fit entirely. Use **wrap text** to make data appear on multiple lines by adjusting the row height to fit the cell contents within the column width. Excel wraps the text on two or more lines within the cell. In Figure 1.41, the Markup Rate and Percent Off labels on row 4 are examples of wrapped text.

To wrap text within a cell, complete the following steps:
1. Click the cells or select the range of cells that contain labels that need to be wrapped.
2. Click Wrap Text in the Alignment group.

**TIP: LINE BREAK IN A CELL**

If a long text label does not fit well in a cell even after you have applied wrap text, you might want to insert a line break to display the text label on multiple lines within the cell. To insert a line break while you are typing a label, press Alt+Enter where you want to start the next line of text within the cell.

**Increase and Decrease Indent**

Cell content is left-aligned or right-aligned based on the default data type. However, you can **indent** the cell contents to offset the data from its current alignment. For example, text is left-aligned, but you can indent it to offset it from the left side. Indenting helps others see the hierarchical structure of data. Accountants often indent the word Totals in financial statements so that it stands out from a list of items above the total row. Values are right-aligned by default, but you can indent a value to offset it from the right side of the cell. In Figure 1.41, Computer System and Desk Chair are indented.

**To increase or decrease the indent of data in a cell, complete the following steps:**
1. Click the cell that contains data.
2. Click Increase Indent or Decrease Indent in the Alignment group.

**TIP: INDENTING VALUES**

Values are right aligned by default. You should align the decimal places in a column of values. If the column label is wide, the values below it appear too far on the right. To preserve the values aligning at the decimal places, use the Align Right horizontal alignment and click Increase Indent to shift the values over to the left a little for better placement.

**Apply Borders and Fill Color**

You can apply a border or fill color to accentuate data in a worksheet. A **border** is a line that surrounds a cell or a range of cells. Use borders to offset some data from the rest of the worksheet data. To apply a border, select the cell or range that you want to have a border, click the Borders arrow in the Font group, and select the desired border type. In Figure 1.41, a border surrounds the range F4:G12. To remove a border, select No Border from the Borders menu.

Add some color to your worksheets to emphasize data or headers by applying a fill color. A **fill color** is a background color that displays behind the data in a cell so that the data stand out. You should choose a fill color that contrasts with the font color. For example, if the font color is Black, Text 1, you might choose Yellow fill color. If the font color is White, Background 1, you might apply Blue or Dark Blue fill color. The color palette contains two sections: Theme Colors and Standard Colors. The Theme Colors section displays variations of colors that match the current theme applied in the worksheet. For example, it contains shades of blue, such as Blue, Accent 5, Lighter 80%. The Standard Colors section contains basic colors, such as Dark Red and Red.

**To apply a fill color, complete the following steps:**
1. Select the cell or range that you want to have a fill color.
2. Click the Fill Color arrow on the Home tab to display the color palette.
3. Select the color choice from the Fill Color palette. In Figure 1.41, the column labels in row 4 contain the Blue, Accent 1, Lighter 80% fill color. If you want to remove a fill color, select No Fill from the bottom of the palette. Select More Colors to open the Colors dialog box, click the Standard tab or Custom tab, and then click a color.

**For additional border and fill color options, complete the following steps:**
1. Click the Dialog Box Launcher in the Font group to display the Format Cells dialog box.
2. Click the Border tab to select border options, including the border line style and color.
3. Click the Fill tab to set the background color, fill effects, and patterns.

**Applying Number Formats**

Values have no special formatting when you enter data. However, you should apply number formats, settings that control how a value is displayed in a cell. For example, you might want to apply either the Accounting or Currency number format to monetary values. Changing the number format changes the way the number displays in a cell, but the format does not change the stored value. If, for example, you enter 123,456 into a
cell and format the cell with the Currency number type, the value shows as $1,234.56 onscreen, but the actual value 1234.56 is used for calculations. When you apply a number format, specify the number of decimal places to display onscreen.

Apply a Number Format

The default number format is General, which displays values as you originally enter them. General number format does not align decimal points in a column or include symbols, such as dollar signs, percent signs, or commas. Table 1.7 lists and describes the primary number formats in Excel.

<table>
<thead>
<tr>
<th>TABLE 1.7 Number Formats</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Format Style</strong></td>
</tr>
<tr>
<td>General</td>
</tr>
<tr>
<td>Number</td>
</tr>
<tr>
<td>Currency</td>
</tr>
<tr>
<td>Accounting Number Format</td>
</tr>
<tr>
<td>Comma Style</td>
</tr>
<tr>
<td>Date</td>
</tr>
<tr>
<td>Time</td>
</tr>
<tr>
<td>Percent Style</td>
</tr>
<tr>
<td>Fraction</td>
</tr>
<tr>
<td>Scientific</td>
</tr>
<tr>
<td>Text</td>
</tr>
<tr>
<td>Special</td>
</tr>
<tr>
<td>Custom</td>
</tr>
</tbody>
</table>

The Number group on the Home tab contains commands for applying Accounting Number Format, Percent Style, and Comma Style numbering formats. You can click the Accounting Number Format arrow and select other denominations, such as English pounds or euros. For other number formats, click the Number Format arrow and select the numbering format you want to use. For more specific numbering formats than those provided, select More Number Formats from the Number Format menu or click the Number Dialog Box Launcher to open the Format Cells dialog box with the Number tab options readily available. Figure 1.42 shows different number formats applied to values.

FIGURE 1.42 Number Formats

Increase and Decrease Decimal Places

After applying a number format, you may need to adjust the number of decimal places that display. For example, if you have an entire column of monetary values formatted in Accounting Number Format, Excel displays two decimal places by default. If the entire column of values contains whole dollar values and no cents, displaying .00 down the column looks cluttered. Decrease the number of decimal places to show whole numbers only.

To change the number of decimal places displayed, complete the following steps:

1. Click the cell or select a range of cells containing values that need to have fewer or more decimal places.
2. Click Increase Decimal in the Number group on the Home tab to display more decimal places for greater precision or Decrease Decimal to display fewer or no decimal places.

11. What is the importance of formatting a worksheet? p. 110
12. Describe five alignment and font formatting techniques used to format labels that are discussed in this section. p. 110
13. What are the main differences between Accounting Number Format and Currency format? Which format has its own command on the Ribbon? p. 114
4 Worksheet Formatting

In the first three Hands-On Exercises, you entered data about products on sale, created formulas to calculate markup and profit, and inserted new rows and columns to accommodate the labels Electronics and Furniture to identify the specific products. You are ready to format the worksheet. Specifically, you will center the title, align text, format values, and apply other formatting to enhance the readability of the worksheet.

**STEP 1** APPLY A CELL STYLE AND MERGE AND CENTER THE TITLE

To make the title stand out, you want to apply a cell style and center it over all the data columns. You will use the Merge & Center command to merge cells and center the title at the same time. Refer to Figure 1.43 as you complete Step 1.

---

**TROUBLESHOOTING:** If you merge too many or not enough cells, unmerge the cells and start again. To unmerge cells, click in the merged cell. The Merge & Center command is shaded in green when the active cell is merged. Click Merge & Center to unmerge the cell. Then select the correct range to merge and use Merge & Center again.

**STEP 2** CHANGE CELL ALIGNMENT

You will wrap the text in the column headings to avoid columns that are too wide for the data, but which will display the entire text of the column labels. In addition, you will horizontally center column labels between the left and right cell margins. Refer to Figure 1.44 as you complete Step 2.

---

**FIGURE 1.43** Cell Style Applied: Data Merged and Centered

a. Open o1h3Markup_LastFirst if you closed it at the end of Hands-On Exercise 3 and save it as o1h4Markup_LastFirst, changing h3 to h4.
b. Select the range A1:L26 and press Delete.
   You maintained a copy of your Paste Special results in the o1h3Markup_LastFirst workbook, but you do not need it to continue.
c. Select the range A1:J1, click Cell Styles in the Styles group on the Home tab, and then click Heading 1.
   You applied the Heading 1 style to the range A1:J1. This style formats the contents with 1.5-pt font size, Blue-Gray Text 2 font color, and a thick blue bottom border.
d. Click Merge & Center in the Alignment group.
   Excel merges cells in the range A1:J1 into one cell and centers the title horizontally within the merged cell, which is cell A1.

**FIGURE 1.44** Formatted Column Labels

a. Select the range A4:I4 to select the column labels.
b. Click Wrap Text in the Alignment group.
   The multiple-word column headings are now visible on two lines within each cell.
c. Click Center in the Alignment group and click Bold in the Font group to format the selected column headings.
   The column headings are centered horizontally between the left and right edges of each cell.
d. Click cell A1, which contains the title, click Middle Align in the Alignment group, and then save the workbook.
   Middle Align vertically centers data between the top and bottom edges of the cell.
**STEP 3: INCREASE INDENT**

As you review the first column, you notice that the category names, Electronics and Furniture, do not stand out. You decide to indent the labels within each category to better display which products are in each category. Refer to Figure 1.45 as you complete Step 3.

**FIGURE 1.45 Indented Cell Contents**

- a. Select the range A6:A8, the cells containing Electronic products labels.
- b. Click Increase Indent in the Alignment group twice.
  
  The three selected product names are indented below the Electronics heading.
- c. Select the range A10:A12, the cells containing furniture products, and click Increase Indent twice.
  
  The three selected product names are indented below the Furniture heading. Notice that the one product name appears cut off.
- d. Increase the column A width to 26.00. Save the workbook.

**STEP 4: APPLY A BORDER AND FILL COLOR**

You want to apply a light blue fill color to highlight the column headings. In addition, you want to emphasize the percent off and sale prices. You will do this by applying a border around that range. Refer to Figure 1.46 as you complete Step 4.

**FIGURE 1.46 Border and Fill Color Applied**

  
  Because you want to apply the same format to nonadjacent ranges, you hold down Ctrl while selecting each range.
- b. Click Accounting Number Format in the Number group. If some cells display pound signs, increase the column widths as needed.
  
  You formatted the selected nonadjacent ranges with the Accounting Number Format. The dollar signs aligns on the left cell margins and the decimals align.
- c. Select the range D6:D12, click Percent Style in the Number group, and then click Increase Decimal in the Number group.
  
  You formatted the values in the selected range with Percent Style and increased the decimal to show one decimal place to avoid misleading your readers by displaying the values as whole percentages.
- d. Apply Percent Style to the range F6:F12.
- e. Select the range G6:H12, apply Percent Style, and then click Increase Decimal.

**FIGURE 1.47 Number Formats and Decimal Places**
f. Select the range F6:F12, click **Align Right**, and then click **Increase Indent** twice. Select the range H6:H112, click **Align Right**, and then click **Increase Indent**.

With values, you want to keep the decimal points aligned, but you can then use **Increase Indent** to adjust the indent so that the values appear more centered below the column labels.

g. Save the workbook. Keep the workbook open if you plan to continue with the next Hands-On Exercise. If not, close the workbook and exit Excel.

---

**Worksheets, Page Setup, and Printing**

When you start a new blank workbook in Excel, the workbook contains one worksheet named Sheet1. However, you can add additional worksheets. The text, values, dates, and formulas you enter into the individual worksheets are saved under one workbook file name. Having multiple worksheets in one workbook is helpful to keep related items together.

Although you might distribute workbooks electronically as email attachments or you might upload workbooks to a corporate server, you should prepare the worksheets in case you need to print them or in case others who receive an electronic copy of your workbook want to print the worksheets.

In this section, you will copy, move, and rename worksheets. You will also select options on the Page Layout tab. Specifically, you will use the Page Setup, Scale to Fit, and Sheet Options groups. After selecting page setup options, you will learn how to print your worksheet.

**Managing Worksheets**

Creating a multiple-worksheet workbook takes some planning and maintenance. Worksheet tab names should reflect the contents of the respective worksheets. In addition, you can insert, copy, move, and delete worksheets within the workbook. You can even apply background color to the worksheet tabs so that they stand out onscreen. Figure 1.48 shows a workbook in which the sheet tabs have been renamed, colors have been applied to worksheet tabs, and a worksheet tab has been right-clicked so that the shortcut menu appears.

**FIGURE 1.48 Worksheet Tabs**

The active sheet tab has a green horizontal bar below the sheet name, and the sheet name is bold and green. If a color (such as Red) has been applied to the sheet tab, the tab shows in the full color when it is not active. When that sheet is active, the sheet tab color is a gradient of the selected color.

**Insert and Delete a Worksheet**

Sometimes you need more than one worksheet in the workbook. For example, you might want one worksheet for each month to track your monthly income and expenses for one year. When tax time comes around, you have all your data stored in one workbook file. You can insert additional, rename, copy, and move worksheets. Adding worksheets within one workbook enables you to save related sheets of data together.
To insert a new worksheet, complete one of the following sets of steps:

- Click New sheet to the right of the last worksheet tab.
- Click the Insert arrow (either to the right or below Insert) in the Cells group on the Home tab and select Insert Sheet.
- Right-click any sheet tab, select Insert from the shortcut menu (refer to Figure 1.48), click Worksheet in the Insert dialog box, and click OK.
- Press Shift+F11.

If you no longer need the data in a worksheet, delete the worksheet. Doing so will eliminate extra data in a file and reduce file size.

To delete a worksheet in a workbook, complete one of the following sets of steps:

- Click the Delete arrow (either to the right or below Delete) in the Cells group on the Home tab and select Delete Sheet.
- Right-click any sheet tab and select Delete from the shortcut menu (refer to Figure 1.48).

If the sheet you are trying to delete contains data, Excel will display a warning: Microsoft Excel will permanently delete this sheet. Do you want to continue? Click Delete to delete the worksheet, or click Cancel to keep the worksheet. If you try to delete a blank worksheet, Excel will not display a warning; it will immediately delete the sheet.

Copy or Move a Worksheet

After creating a worksheet, you may want to copy it to use as a template or starting point for similar data. For example, if you create a worksheet for your September budget, you might want to copy the worksheet and easily edit the data on the copied worksheet to enter data for your October budget. Copying the entire worksheet saves you a lot of valuable time in entering and formatting the new worksheet, and it preserves the column widths and row heights. The process for copying a worksheet is similar to moving a sheet.

To copy a worksheet, complete one of the following sets of steps:

- Press and hold Ctrl as you drag the worksheet tab.
- Right-click the sheet tab, select Move or Copy to display the Move or Copy dialog box, select the To book and Before sheet options (refer to Figure 1.49), click the Create a copy check box, and then click OK.

You can arrange the worksheet tabs in a different sequence. For example, if the December worksheet is to the left of the October and November worksheets, move the December worksheet to be in chronological order.

To move a worksheet, complete one of the following sets of steps:

- Drag a worksheet tab to the desired location. As you drag a sheet tab, the pointer resembles a piece of paper. A down-pointing triangle appears between sheet tabs to indicate where the sheet will be placed when you release the mouse button.
- Click Format in the Cells group on the Home tab (refer to Figure 1.35) and select Move or Copy Sheet.
- Right-click the sheet tab you want to move and select Move or Copy to display the Move or Copy dialog box. You can move the worksheet within the current workbook or to a different workbook. In the Before sheet list, select the worksheet you want to come after the moved worksheet and click OK.

Rename a Worksheet

The default worksheet name Sheet1 does not describe the contents of the worksheet. You should rename worksheet tabs to reflect the sheet contents. For example, if your budget workbook contains monthly worksheets, name the worksheets September, October, etc. Although you can have spaces in worksheet names, keep worksheet names relatively short. The longer the worksheet names, the fewer sheet tabs you will see at the bottom of the workbook window without scrolling.

To rename a worksheet, complete one of the following sets of steps:

- Double-click a sheet tab, type the new name, and then press Enter.
- Click the sheet tab for the sheet you want to rename, click Format in the Cells group on the Home tab (refer to Figure 1.35), select Rename Sheet, type the new sheet name, and then press Enter.
- Right-click the sheet tab, select Rename from the shortcut menu (refer to Figure 1.48), type the new sheet name, and then press Enter.

TIP: CHANGE TAB COLOR
You can change the color of each worksheet tab to emphasize the difference among the sheets. For example, you might apply red to the September tab and yellow to the October tab. Right-click a sheet tab, select Tab Color, and select a color from the color palette.

Selecting Page Setup Options

The Page Setup group on the Page Layout tab contains options to set the margins, select orientation, specify page size, select the print area, and apply other options (see Figure 1.50). The Scale to Fit group contains options for adjusting the scaling of the spreadsheet on the printed page. When possible, use the commands in these groups to apply page settings. Table 1.8 lists and describes the commands in the Page Setup group.

FIGURE 1.49 Move or Copy Dialog Box

FIGURE 1.50 Page Layout Tab
### TABLE 1.8 Page Setup Commands

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Margins</strong></td>
<td>Displays a menu to select predefined margin settings. The default margins are 0.75&quot; top and bottom and 0.75&quot; left and right. You will often change these margin settings to balance the worksheet data better on the printed page. If you need different margins, select Custom Margins.</td>
</tr>
<tr>
<td><strong>Orientation</strong></td>
<td>Displays orientation options. The default page orientation is portrait, which is appropriate for worksheets that contain more rows than columns. Select landscape orientation when worksheets contain more columns than rows. Select portrait orientation for worksheets that contain more columns than rows. For example, the OKOS worksheet might appear better balanced in landscape orientation because it has eight columns.</td>
</tr>
<tr>
<td><strong>Size</strong></td>
<td>Displays a list of standard paper sizes. The default size is 8 1/2&quot; by 11&quot;. If you have a different paper size, such as legal paper, select it from the list.</td>
</tr>
<tr>
<td><strong>Print Area</strong></td>
<td>Displays a list to set or clear the print area. When you have very large worksheets, you might want to print only a portion of that worksheet. To do so, select the range you want to print, click Print Area in the Page Setup group, and select Set Print Area. When you use the Print command, only the range you specified will be printed. To clear the print area, click Print Area and select Clear Print Area.</td>
</tr>
<tr>
<td><strong>Breaks</strong></td>
<td>Displays a menu to insert or remove page breaks.</td>
</tr>
<tr>
<td><strong>Background</strong></td>
<td>Enables you to select an image to appear as the background behind the worksheet data when viewed onscreen (backgrounds do not appear when the worksheet is printed).</td>
</tr>
<tr>
<td><strong>Print Titles</strong></td>
<td>Enables you to select column headings and row labels to repeat on multiple-page printouts.</td>
</tr>
</tbody>
</table>

---

**TIP: APPLYING PAGE SETUP OPTIONS TO MULTIPLE WORKSHEETS**

When you apply Page Setup options, those settings apply to the current worksheet only. However, you can apply page setup options, such as margins or a header, to multiple worksheets at the same time. To select adjacent sheets, click the first sheet tab, press and hold Shift, and click the last sheet tab. To select nonadjacent sheets, press and hold Ctrl as you click each sheet tab. Then choose the Page Setup options to apply to the selected sheets. When you are done, right-click a sheet tab and select Ungroup Sheets.

---

**Specify Page Options**

To apply several page setup options at once or to access options not found on the Ribbon, click the Page Setup Dialog Box Launcher. The Page Setup dialog box organizes options into four tabs: Page, Margins, Header/Footer, and Sheet. All tabs contain Print and Print Preview buttons. Figure 1.51 shows the Page tab.

---

**FIGURE 1.51 Page Setup Dialog Box: Page Tab**

The Page tab contains options to select the orientation and paper size. In addition, it contains scaling options that are similar to the options in the Scale to Fit group on the Page Layout tab. You use scaling options to increase or decrease the size of characters on a printed page, similar to using a zoom setting on a photocopy machine. You might want to use the Fit to option to force the data to print on a specified number of pages.

**Set Margin Options**

The Margins tab (see Figure 1.52) contains options for setting the specific margins. In addition, it contains options to center the worksheet data horizontally or vertically on the page, which are used to balance worksheet data equally between the left and right margins or top and bottom margins, respectively.
Create Headers and Footers

**STEP 3** The Header/Footer tab (see Figure 1.53) lets you create a header and/or footer that appears at the top and/or bottom of every printed page. Click the arrows to choose from several preformatted entries, or alternatively, click Custom Header or Custom Footer, insert text and other objects, and click the appropriate formatting button to customize the headers and footers. Use headers and footers to provide additional information about the worksheet. You can include your name, the date the worksheet was prepared, and page numbers, for example.

---

**FIGURE 1.53 Page Setup Dialog Box: Margins Tab**

**FIGURE 1.53 Page Setup Dialog Box: Header/Footer Tab**

You can create different headers or footers on different pages, such as on one header with the file name on odd-numbered pages and a header containing the date on even-numbered pages. Click the Different odd and even pages check box to select it in the Page Setup dialog box (see Figure 1.53).

You might want the first page to have a different header or footer from the rest of the printed pages, or you might not want a header or footer to show up on the first page but want the header or footer to display on the remaining pages. Click the Different first page check box to select it in the Page Setup dialog box to specify a different first page header or footer.

Instead of creating headers and footers using the Page Setup dialog box, you can click the Insert tab and click Header & Footer in the Text group. Excel displays the worksheet in Page Layout view with the insertion point in the center area of the header. Click inside the left, center, or right section of a header or footer. When you click inside a section within the header or footer, Excel displays the Header & Footer Tools Design contextual tab (see Figure 1.54). Enter text or insert data from the Header & Footer Elements group on the tab. Table 1.9 lists and describes the options in the Header & Footer Elements group. To get back to Normal view, click any cell in the worksheet and click Normal in the Workbook Views group on the View tab.
By default, Excel displays gridlines onscreen to show you each cell’s margins, but the gridlines do not print unless you specifically select the Gridlines check box in the Page Setup dialog box or the Print Gridlines check box in the Sheet Options group on the Page Layout tab. In addition, Excel displays row (1, 2, 3, etc.) and column (A, B, C, etc.) headings onscreen. However, these headings do not print unless you click the Row and Column headings check box in the Page Setup dialog box or click the Print Headings check box in the Sheet Options group on the Page Layout tab. For most worksheets, you do not need to print gridlines and row/column headings. However, when you want to display and print cell formulas instead of formula results, you might want to print the gridlines and row/column headings. Doing so will help you analyze your formulas. The gridlines help you see the cell boundaries, and the headings help you identify what data are in each cell. At times, you might want to display gridlines to separate data on a regular printout to increase readability.

![Table 1.9: Header & Footer Elements Options](image)

<table>
<thead>
<tr>
<th>Option Name</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page Number</td>
<td>Inserts the code &amp;{Page} to display the current page number.</td>
</tr>
<tr>
<td>Number of Pages</td>
<td>Inserts the code &amp;{Pages} to display the total number of pages that will print.</td>
</tr>
<tr>
<td>Current Date</td>
<td>Inserts the code &amp;{Date} to display the current date, such as 5/19/2018. The date is updated to the current date when you open or print the worksheet.</td>
</tr>
<tr>
<td>Current Time</td>
<td>Inserts the code &amp;{Time} to display the current time, such as 5:15 PM. The time is updated to the current time when you open or print the worksheet.</td>
</tr>
<tr>
<td>File Path</td>
<td>Inserts the code &amp;{Path} &amp;{File} to display the path and file name, such as C:\Users\Ketch\Documents\01March14Markup. This information changes if you save the workbook with a different name or in a different location.</td>
</tr>
<tr>
<td>File Name</td>
<td>Inserts the code &amp;{File} to display the file name, such as 01March14Markup. This information changes if you save the workbook with a different name.</td>
</tr>
<tr>
<td>Sheet Name</td>
<td>Inserts the code &amp;{Tab} to display the worksheet name, such as September. The information changes if you rename the worksheet.</td>
</tr>
<tr>
<td>Picture</td>
<td>Inserts the code &amp;{Picture} to display and print an image as a background behind the data, not just the worksheet.</td>
</tr>
<tr>
<td>Format Picture</td>
<td>Enables you to adjust the brightness, contrast, and size of an image after you use the Picture option.</td>
</tr>
</tbody>
</table>

**TIP: VIEW TAB**

If you click the View tab and click Page Layout, Excel displays an area Click to add header at the top of the worksheet.

**Select Sheet Options**

The Sheet tab (see Figure 1.55) contains options for setting the print area, print titles, print options, and page order. Some of these options are also located in the Sheet Options group on the Page Layout tab.

![Figure 1.55: Page Setup Dialog Box: Sheet Tab](image)

**TIP: REPEATING ROWS AND COLUMNS**

If you have spreadsheet data that would take more than one printed page, open the Page Setup dialog box, click the Sheet tab, click in the Rows to repeat at top box, and then select the row(s) containing column labels. That way, when the pages print, the rows containing the descriptive column labels will repeat at the top of each printed page so that you can easily know what data is in each column. Likewise, if the spreadsheet has too many columns to print on one page, you can click in the Columns to repeat at left box on the Sheet tab within the Page Setup dialog box and select the column(s) so that the row labels will display on the left side of each printed page.

**Previewing and Printing a Worksheet**

Microsoft Office Backstage view displays print options and displays the worksheet in print preview mode. Print preview helps you see before printing if the data are balanced on the page or if data will print on multiple pages.
You can specify the number of copies to print and which printer to use to print the worksheet. The first option in the Settings area specifies what to print. The default option is Print Active Sheets. You might want to choose other options, such as Print Entire Workbook or Print Selection, or specify which pages to print. If you are connected to a printer capable of duplex printing, you can print on only one side or print on both sides. You can also collate, change the orientation, specify the paper size, adjust the margins, and adjust the scaling.

The bottom of the Print window indicates how many pages will print. If you do not like how the worksheet will print, click Page Setup at the bottom of the print settings to open the Page Setup dialog box so that you can adjust margins, scaling, column widths, and so on until the worksheet data appear the way you want them to print.

**TIP: PRINTING MULTIPLE WORKSHEETS**

To print more than one worksheet at a time, select the sheets you want to print. To select adjacent sheets, click the first sheet tab, press and hold Shift, and click the last sheet tab. To select nonadjacent sheets, press and hold Ctrl as you click each sheet tab. When you display the Print options in Microsoft Office Backstage view, Print Active Sheets is one of the default settings. If you want to print all of the worksheets within the workbook, change the setting to Print Entire Workbook.

14. Why would you insert several worksheets of data in one workbook instead of creating a separate workbook for each worksheet? p. 121

15. Why would you select a Center on page option in the Margins tab within the Page Setup dialog box if you have already set the margins? p. 125

16. List at least five elements you can insert in a header or footer. p. 128

17. Why would you want to print gridlines and row and column headings? p. 129

---

**5 Worksheets, Page Setup, and Printing**

You are ready to complete the OKOS worksheet. You want to copy the existing worksheet so that you display the results on the original sheet and display formulas on the duplicate sheet. Before printing the worksheet for your supervisor, you want to make sure the data will appear professional when printed. You will adjust some page setup options to print the finishes touches on the worksheet.

---

**STEP 1  BUILDING A NEW WORKSHEET**

You want to copy the worksheet, move it to the right side of the original worksheet, and rename the duplicate worksheet so that you can show formulas on the duplicate sheet. Refer to Figure 1.56 as you complete Step 1.

---

**FIGURE 1.56 Worksheets**

a. Open e01b4Markup_LastFirst if you closed it at the end of Hands-On Exercise 4 and save it as e01b5Markup_LastFirst, changing b4 to b5.

b. Right-click the Sheet1 tab at the bottom of the worksheet and select Move or Copy.

The Move or Copy dialog box opens so that you can move the existing worksheet or make a copy of it.

c. Click the Create a copy check box to select it and click OK.

The duplicate worksheet is named Sheet1 (2) and is placed to the left of the original worksheet.

d. Drag the Sheet1 (2) worksheet tab to the right of the Sheet1 worksheet tab.

The duplicate worksheet is now on the right side of the original worksheet.

e. Right-click the Sheet1 sheet tab, select Rename, type September, and then press Enter. Rename Sheet1 (2) as Formulas.

You renamed the original worksheet as September to reflect the September sales data, and you renamed the duplicate worksheet as Formulas to indicate that you will keep the formulas displayed on that sheet.
f. Press Ctrl+* to display the formulas in the Formulas worksheet.

g. Change these column widths in the Formulas sheet:
   - Column A (13.00)
   - Columns C and D (6.00)
   - Columns E, G, B, and I (7.00)
   - Column F (5.00)

You reduced the column widths so that the data will fit on a printout better.

h. Save the workbook.

**STEP 3**  
**SET PAGE ORIENTATION, SCALING, AND MARGIN OPTIONS**

Because the worksheet has several columns, you decide to print it in landscape orientation. You want to set a 1" top margin and center the data between the left and right margins. Furthermore, you want to make sure the data fits on one page on each sheet. Currently, if you were to print the Formulas worksheet, the data would print on two pages. Refer to Figure 1.57 as you complete Step 2.

![Figure 1.57 Page Setup Options Applied](image)

**FIGURE 1.57** Page Setup Options Applied

- **a.** Click the **September sheet tab**, press and hold down **Ctrl**, and then click the **Formulas sheet tab**.
  - Both worksheets are grouped together as indicated by [Group] after the file name on the title bar. Anything you do on one sheet affects both sheets.

- **b.** Click the **Page Layout tab**, click **Orientation** in the Page Setup group, and then select **Landscape** from the list.
  - Because both worksheets are grouped, both worksheets are formatted in landscape orientation.

- **c.** Click **Margins** in the Page Setup group on the Page Layout tab and select **Custom Margins**.
  - The Page Setup dialog box opens with the Margins tab options displayed.

- **d.** Click the **Top spin arrow** to display 1.
  - Because both worksheets are grouped, the 1" top margin is set for both worksheets.

- **e.** Click the **Horizontally check box** to select it in the Center on page section.
  - Because both worksheets are grouped, the data on each worksheet is centered between the left and right margins.

- **f.** Click the **Page tab** within the Page Setup dialog box, click **Fit to** in the Scaling section, and then click **OK**. Save the workbook.
  - The Fit to option ensures that each sheet fits on one page.

---

**STEP 3**  
**CREATE A HEADER**

To document the grouped worksheets, you want to include your name, the sheet name, and the file name in a header. Refer to Figure 1.58 as you complete Step 3.

![Figure 1.58 Header](image)

- **a.** Ensure the worksheets are still grouped, click the **Insert tab**, and then click **Header & Footer** in the Text group.
  - Excel displays the Header & Footer Tools Design contextual tab and the worksheet displays in Page Layout view, which displays the header area, margin space, and ruler. The insertion point blinks inside the center section of the header.

- **b.** Click in the left section of the header and type your name.

- **c.** Click in the center section of the header and click **Sheet Name** in the Header & Footer Elements group on the Design tab.
  - Excel inserts the code {Sheet}. This code displays the name of the worksheet. If you change the worksheet tab name, the header will reflect the new sheet name.

- **d.** Click in the right section of the header and click **File Name** in the Header & Footer Elements group on the Design tab.
  - Excel inserts the code {File}. This code displays the name of the file. Because the worksheets were grouped when you created the header, a header will appear on both worksheets. The file name will be the same; however, the sheet names will be different.
Chapter Objectives Review

After reading this chapter, you have accomplished the following objectives:

1. Explore the Excel window.
   - A worksheet is a single spreadsheet containing data.
   - A workbook is a collection of one or more related worksheets contained in a single file.
   - Identify Excel window elements: The Name Box displays the name of the current cell. The Formula Bar displays the contents of the current cell. The active cell is the current cell. A sheet tab shows the name of the worksheet.
   - Identify columns, rows, and cells: Columns have alphabetical headings, such as A, B, C. Rows have numbers, such as 1, 2, 3. A cell is the intersection of a column and row and is indicated with a column letter and a row number.
   - Navigate in and among worksheets: Use the arrow keys to navigate within a sheet, or use the Go To command to go to a specific cell. Click a sheet tab to display the contents on another worksheet.

2. Enter and edit cell data.
   - You should plan the worksheet design by stating the purpose, deciding what output you need, and then identifying what input values are needed. Next, you enter and format data in a worksheet. Finally, you document, save, and then share a workbook.
   - Enter text: Text may contain letters, numbers, symbols, and spaces. Text aligns at the left side of a cell.
   - Use Auto Fill to complete a sequence. Auto Fill can automatically fill in sequences, such as month names or values, after you enter the first label or value. Double-click the fill handle to fill in the sequence.
   - Enter values: Values are numbers that represent a quantity. Values align at the right side of a cell by default.
   - Enter dates and times: Excel stores dates and times as serial numbers so that you can calculate the number of days between dates or times.
   - Edit and clear contents: You might want to edit the contents of a cell to correct errors or to make labels more descriptive. Use the Clear option to clear the cell contents and/or formats.

3. Create formulas.
   - A formula is used to perform a calculation. The formula results display in the cell.
   - Use cell references in formulas: Use references, such as =B5+B6, instead of values within formulas.
   - Apply the order of operations: The most commonly used operators are performed in this sequence: Parentheses, exponentiation, multiplication, division, addition, and subtraction.

4. Display cell formulas.
   - By default, the results of formulas appear in cells.
   - Display formulas by pressing Ctrl+*.

5. Manage columns and rows.
   - Insert columns, columns, and rows: Insert a cell to move the remaining cells down or to the right. Insert a new column or row for data.
   - Delete cells, columns, and rows: You should delete cells, columns, and rows you no longer need.
   - Hide and unhide columns and rows: Hiding rows and columns protects confidential data from being displayed.
   - Adjust column width: Double-click between the column headings to widen a column based on the longest item in that column, or drag the border between column headings to increase or decrease a column width.
   - Adjust row height: Drag the border between row headings to increase or decrease the height of a row.

6. Select, move, copy, and paste data.
   - Select a range: A range may be a single cell or a rectangular block of cells.
   - Move a range to another location: After selecting a range, cut it from its location. Then select the top-left corner of the destination range to make it the active cell and paste the range there.
   - Copy and paste a range: After selecting a range, click Copy, click the top-left corner of the destination range, and then click Paste to make a copy of the original range.
   - Use Paste Options and Paste Special: The Paste Special option enables you to specify how the data are pasted into the worksheet.
   - Copy Excel data to other programs: You can copy Excel data and paste it in other programs, such as in Word or PowerPoint.

7. Apply cell styles, alignment, and font options.
   - Cell styles contain a collection of formatting, such as font, font color, font size, fill, and borders. You can apply an Excel cell style to save formatting time.
   - Merge and center labels: Type a label in the left cell, select a range including the data you typed, and then click Merge & Center to merge cells and center the label within the newly merged cell.
• Change horizontal and vertical cell alignment: The default horizontal alignment depends on the data entered, and the default vertical alignment is Bottom Align.
• Wrap text: Use the Wrap Text option to present text on multiple lines in order to avoid having extra-wide columns.
• Increase and decrease indent: To indicate hierarchy of data or to offset a label, increase or decrease how much the data are indented in a cell.
• Apply borders and fill colors: Borders and fill colors help improve readability of worksheets.

8. Apply number formats.
• Apply a number format: The default number format is General, which does not apply any particular format to values. Apply appropriate formats to values to present the data with the correct symbols and decimal alignment. For example, Accounting Number Format is a common number format for monetary values.
• Increase and decrease decimal places: After applying a number format, you might want to increase or decrease the number of decimal places displayed.

9. Manage worksheets.
• Insert and delete a worksheet: You can insert new worksheets to include related data within one workbook, or you can delete extra worksheets you do not need.
• Copy or move a worksheet: Drag a sheet tab to rearrange the worksheets. You can copy a worksheet within a workbook or to another workbook.
• Rename a worksheet: The default worksheet tab name is Sheet1, but you should change the name to describe the contents of the worksheet.

10. Select page setup options.
• The Page Layout tab on the Ribbon contains options for setting margins, selecting orientation, specifying page size, selecting the print area, and applying other settings.
• Specify page options: Page options include orientation, paper size, and scaling.
• Set margin options: You can set the left, right, top, and bottom margins. In addition, you can center worksheet data horizontally and vertically on a page.
• Create headers and footers: Insert a header or footer to display documentation, such as your name, date, time, and worksheet tab name.
• Select sheet options: Sheet options control the print area, print titles, print options, and page order.

11. Preview and print a worksheet.
• Before printing a worksheet, you should display a preview to ensure the data will print correctly. The Print Preview helps you see if margins are correct or if isolated rows or columns will print on separate pages.
• After making appropriate adjustments, you can print the worksheet.

Match the key terms with their definitions. Write the key term letter by the appropriate numbered definition.

a. Alignment
b. Auto Fill
c. Cell
d. Column width
e. Fill color
f. Fill handle
g. Formula
h. Formula Bar
i. Input area
j. Name Box
k. Order of operations
l. Output area
m. Range
n. Row height
o. Sheet tab
p. Text
q. Value
r. Workbook
s. Worksheet
t. Wrap text

1. _____ A spreadsheet that contains formulas, functions, values, text, and visual aids. p. 70
2. _____ A file containing related worksheets. p. 70
3. _____ A range of cells containing values for variables used in formulas. p. 73
4. _____ A range of cells containing data results based on manipulating the variables. p. 73
5. _____ Identifies the address of the current cell. p. 71
6. _____ Displays the content (text, value, date, or formula) in the active cell. p. 71
7. _____ Displays the name of a worksheet within a workbook. p. 71
8. _____ The intersection of a column and row. p. 72
9. _____ Includes letters, numbers, symbols, and spaces. p. 74
10. _____ A number that represents a quantity or an amount. p. 77
11. _____ Rules that control the sequence in which Excel performs arithmetic operations. p. 84
12. _____ Enables you to copy the contents of a cell or cell range or to continue a sequence by dragging the fill handle over an adjacent cell or range of cells. p. 75
13. _____ A small green square at the bottom-right corner of a cell. p. 76
14. _____ The horizontal measurement of a column. p. 97
15. _____ The vertical measurement of a row. p. 98
16. _____ A rectangular group of cells. p. 98
17. _____ The position of data between the cell margins. p. 111
18. _____ Formatting that enables a label to appear on multiple lines within the current cell. p. 112
19. _____ The background color appearing behind data in a cell. p. 113
20. _____ A combination of cell references, operators, values, and/or functions used to perform a calculation. p. 83
1. Which step is not part of planning a worksheet design?  
(a) Decide what input values are needed.  
(b) State the purpose of the worksheet.  
(c) Decide what outputs are needed to achieve the purpose.  
(d) Enter labels, values, and formulas.  

2. You just copied a range of data containing formulas. However, you want to preserve the formula results and the original number and text formatting in the pasted range. Which paste option would you select?  
(a) Formulas  
(b) Keep Source Formatting  
(c) Values & Source Formatting  
(d) Values & Number Formatting  

3. Given the formula =B1*B2+B3/B4*2, what operation is calculated first?  
(a) B1*B2  
(b) B2+B3  
(c) B3/B4  
(d) B4*2  

4. How can you display formulas within the cells instead of the cell results?  
(a) Press Ctrl+I.  
(b) Press Ctrl+*  
(c) Click Cell References on the Home tab.  
(d) Press Ctrl+C.  

5. What is a fast way to apply several formats at one time?  
(a) Click each one individually.  
(b) Apply a cell style.  
(c) Use Auto Fill.  
(d) Use Copy and Paste options.  

6. Which of the following is not an alignment option?  
(a) Increase Indent  
(b) Merge & Center  
(c) Fill Color  
(d) Wrap Text  

7. Which of the following characteristics is not applicable to the Accounting Number Format?  
(a) Dollar sign immediately on the left side of the value  
(b) Commas to separate thousands  
(c) Two decimal places  
(d) Zero values displayed as hyphens  

8. You selected and copied worksheet data containing formulas. However, you want to paste the copied to contain the current formula results rather than formulas. What do you do?  
(a) Click Paste in the Clipboard group on the Home tab.  
(b) Click the Paste arrow in the Clipboard group and select Values.  
(c) Click the Paste arrow in the Clipboard group and select Values & Formatting.  
(d) Display the Paste Special dialog box and select Values & Number Formatting.  

9. Assume that the data on a worksheet consumes a whole printed page and a couple of columns on a second page. You can do all of the following except what to force the data to print all on one page?  
(a) Decrease the Scale value.  
(b) Increase the left and right margins.  
(c) Decrease column widths if possible.  
(d) Select a smaller range as the print area.  

10. What should you do if you see pound signs (# # #) instead of values or results of formulas?  
(a) Increase the room percentage.  
(b) Delete the column.  
(c) Adjust the row height.  
(d) Increase the column width.  

Mathematics Review

You want to brush up on your math skills to test your logic by creating formulas in Excel. You realize that you should avoid values in formulas most of the time. Therefore, you created an input area that contains values you use to use your formulas. To test your knowledge of formulas, you will create an output area that will contain a variety of formulas using cell references from the input area. You will include a formatted title, the data prepared, and your name. After creating and verifying formula results, you will change input values and observe changes in the formula results. You want to display cell formulas, so you will create a picture copy of the formulas view. Refer to Figure 1.60 as you complete this exercise.

Excel Formulas and Order of Precedence

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Data Created: 4:28:24</td>
<td>Student Name</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td>2</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>3</td>
<td>Input Area</td>
<td>Output Area</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Sum of 1st and 2nd values</td>
<td>=B5+B6</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Difference between 4th and 1st values</td>
<td>=B8-B5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Product of 3rd and 3rd values</td>
<td>=B9*B9</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Sum of 1st and 3rd values</td>
<td>=B5+B8</td>
<td>B9</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>2nd value to the power of 3rd value</td>
<td>=B6^B9</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>1st value added to product of 2nd and 4th values and difference between sum and 3rd value</td>
<td>=B5+B6+B8-B7</td>
<td>B9+B5</td>
<td>B6-B7</td>
</tr>
<tr>
<td>10</td>
<td>Product of sum of 1st and 2nd and difference between 4th and 3rd values</td>
<td>=B5+B6*B8-B7</td>
<td>B9+B5</td>
<td>B6-B7</td>
</tr>
<tr>
<td>11</td>
<td>Product of 1st and 2nd added to product of 3rd and 4th values</td>
<td>=B5<em>B6+B9</em>B8</td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

FIGURE 1.60 Formula Practice

a. Open 01p1Math and save it as 01p1 Math_LastFirst.
b. Type the current date in cell B2 in this format: 9/1/2018. Type your first and last names in cell D2.
c. Adjust the column widths by doing the following:  
   • Click in any cell in column A and click Format in the Cells group.  
   • Select Column Width. Type 12.57 in the Column width box, and then click OK.  
   • Click in any cell in column B and set the width to 11.  
   • Click in any cell in column D and set the width to 15.57.
d. Select the range A1:E1, click Merge & Center in the Alignment group, click Bold in the Font group, and then change the font size to 14.
e. Select the range B5:B8 and click Center in the Alignment group.
f. Select the range D10:D12 and click Wrap Text in the Alignment group.
g. Enter the following formulas in column E:  
   • Click cell E5. Type =B5+B6 and press Enter. Excel adds the value stored in cell B5 to the value stored in cell B6 (1). The result (1) appears in cell E5, as described in cell D5.  
   • Enter appropriate formulas in cells E6:E8 in the following manner: press Enter after entering each formula. Subtract to calculate a difference, multiply to calculate a product, and divide to calculate a quotient.  
   • Type =B6^B7 in cell E9 and press Enter. Calculate the answer: 2*2*2 = 8.  
   • Enter =B5+B6+B8-B7 in cell E10 and press Enter. Calculate the answer: 2^4 = 8 + 1 + 8 = 9 + 9 + 3 = 21. Multiplication occurs first, followed by addition, and finally subtraction.  
   • Enter =B5+B6+B8 in cell E11 and press Enter. Calculate the answer: 1 + 2 + 3 = 6.  
   • Enter =B5*B6+B7+B8 in cell E12 and press Enter. Calculate the answer: 1^2 = 1; 3^2 = 9; 2^3 = 8; 3*4 = 12; 2+12 = 14.
**Calendar Formatting**

You want to create a calendar for July 2018. The calendar will enable you to practice alignment settings, including center, merge and center, and indents. In addition, you will need to adjust column widths and increase row height to create cells large enough to enter important information, such as birthdays, in your calendar. You will create a formula and use Auto Fill to complete the days of the week and the days within each week. To improve the appearance of the calendar, you will add fill colors, font colors, and borders to create a red, white, and blue effect to celebrate Independence Day. Refer to Figure 1.61 as you complete this exercise.

---

**FIGURE 1.61 Calendar**

- Click the File tab, select New, and click Blank workbook. Save the workbook as e01p1July_LastFirst.
- Type ‘July 2018’ in cell A1 and click Enter on the left side of the Formula Bar.

**TROUBLESHOOTING:** If you do not type the apostrophe before July 2018, the cell will display July-18 instead of July 2018.

- Format the title:
  - Select the range A1:G1 and click Merge & Center in the Alignment group.
  - Change the font size to 36.
  - Click the Fill Color arrow and click Blue in the Standard Colors section of the color palette.
  - Click Middle Align in the Alignment group.

- Complete the days of the week:
  - Type Sunday in cell A2 and click Enter to the left side of the Formula Bar.
  - Drag the cell A2 fill handle across the row through cell G2 to use Auto Fill to complete the rest of the weekdays.
  - Ensure that the range A2:G2 is selected. Click the Fill Color arrow and select Blue, Accent 1, Lighter 40% in the Theme Colors section of the color palette.
  - Apply bold and change the font size to 14 size to the selected range.
  - Click Middle Align and click Center in the Alignment group to format the selected range.

- Complete the days of the month:
  - Type 1 in cell A3 and press Ctrl+Enter. Drag the cell A3 fill handle across the row through cell G3.
  - Click Auto Fill Options in the bottom-right corner of the copied data and select Fill Series to change the numbers to 1 through 31.
  - Type =A3+7 in cell A4 and press Ctrl+Enter. Usually you avoid numbers in formulas, but the number of days in a week is always 7. Drag the cell A4 fill handle down through cell A7 to get the date for each Sunday in July.
Downtown Theatre

You are the assistant manager at Downtown Theatre, where touring Broadway plays and musicals are performed. You will analyze ticket sales by completing a worksheet that focuses on seating charts for each performance. The spreadsheet will identify the seating sections, total seats in each section, and the number of seats sold for a performance. You will then calculate the percentage of seats sold and unsold. Refer to Figure 1.62 as you complete this exercise.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Downtown Theatre</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Ticket Sales by Seating Section</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td>3/31/2018</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Section</td>
<td>Available Seats</td>
<td>Seats Sold</td>
<td>Percentage Sold</td>
<td>Percentage Unsold</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>5</td>
<td>6</td>
<td>Box Seats</td>
<td>25</td>
<td>12</td>
<td>48.0%</td>
</tr>
<tr>
<td>6</td>
<td>7</td>
<td>Front Floor</td>
<td>120</td>
<td>114</td>
<td>95.0%</td>
</tr>
<tr>
<td>7</td>
<td>8</td>
<td>Back Floor</td>
<td>132</td>
<td>109</td>
<td>81.8%</td>
</tr>
<tr>
<td>8</td>
<td>9</td>
<td>Tier 1</td>
<td>40</td>
<td>40</td>
<td>100.0%</td>
</tr>
<tr>
<td>9</td>
<td>10</td>
<td>Mezzanine</td>
<td>144</td>
<td>138</td>
<td>95.8%</td>
</tr>
<tr>
<td>10</td>
<td>11</td>
<td>Balcony</td>
<td>106</td>
<td>84</td>
<td>79.2%</td>
</tr>
</tbody>
</table>

FIGURE 1.62 Theatre Seating Data

a. Open e01p3TicketSales and save it as e01p3TicketSales_LastFirst.
b. Double-click the Sheet1 sheet tab, type Seating, and press Enter.
d. Format the title:
   - Select the range A1:E1 and click Merge & Center in the Alignment group.
   - Click Cell Styles in the Styles group and select Title in the Themes and Headings section.
   - Click Bold in the Font group.
e. Format the subtitle and date:
   - Use the Merge & Center command to merge the range A2:E2 and center the subtitle.
   - Use the Merge & Center command to merge the range A3:E3 and center the date.
f. Select the range A5:E5, click Wrap Text, click Center, and click Bold to format the column labels.
g. Right-click the row 9 heading and select Insert from the shortcut menu to insert a new row.
   - Type the following data in the new row: Back Floor, 112, 108.
h. Move the Balcony row to be the last row by doing the following:
   - Click the row 6 heading and click Cut in the Clipboard group on the Home tab.
   - Right-click the row 12 heading and select Insert Cut Cells from the menu.
i. Adjust column widths by doing the following:
   - Double-click between the column A and column B headings.
   - Select columns B and C headings to select the columns. Click Format in the Cells group, select Column Width, type 9 in the Column width box, and then click OK. Because columns B and C contain similar data, you set the same width for these columns.
   - Set the width of columns D and E to 12.

j. Select the range B6:C11, click Align Right in the Alignment group, and then click Increase Indent twice in the Alignment group.
Mid-Level Exercises

k. Click cell D6 and use semi-selection to calculate and format the percentage of sold and unsold seats by doing the following:
   - Type =, click cell C6, type /, and then click cell B6 to enter =C6/B6.
   - Press Tab to enter the formula and make cell E6 the active cell. This formula divides the number of seats sold by the total number of Box Seats.
   - Type =B6-B6/B6 and click Enter on the left side of the Formula Bar to enter the formula and keep cell E6 the active cell. This formula must first subtract the number of sold seats from the available seats to calculate the number of unsold seats. The difference is divided by the total number of available seats to determine the percentage of unsold seats.
   - Select the range D6:E6, click Percent Style in the Number group, and then click Increase Decimal in the Number group. Keep the range selected.
   - Double-click the cell E6 fill handle to copy the selected formulas down their respective columns. Keep the range selected.
   - Click Align Right in the Alignment group and click Increase Indent twice in the Alignment group. These actions will help center the data below the column labels. Do not click Center; doing so will center each value and cause the decimal points not to align. Deselect the range.

l. Display and preserve a screenshot of the formulas by doing the following:
   - Click New sheet. double-click the Sheet1 sheet tab, type Formulas, and then press Enter.
   - Click the View tab and click Gridlines in the Show group to hide the gridlines in the Formulas worksheet. This action will prevent the cell gridlines from bleeding through the next page you are about to embed.
   - Click the Seating sheet tab, click the Formulas tab on the Ribbon, and then click Show Formulas in the Formula Auditing group to display cell formulas.
   - Click cell A1 and drag down to cell E11 to select the range of data.
   - Click the Home tab, click Copy arrow in the Clipboard group, select Copy as Picture, and then click OK in the Copy Picture dialog box.
   - Click the Formulas sheet tab, click cell A1, and then click Paste.
   - Click the Page Layout tab, click Orientation in the Page Setup group, and then select Landscape to change the orientation for the Formulas sheet.
   - Click the Seating sheet tab, click the Formulas tab, and then click Show Formulas in the Formula Auditing group to hide the cell formulas.

m. Click the Seating sheet tab, press Ctrl and click the Formulas sheet tab to group the two sheets. Click the Page Layout tab, click Margins in the Page Setup group, and then select Custom Margins. Click the Horizontally check box to select it and click Print Preview. Excel centers the data horizontally based on the widest item in each worksheet. Verify that the worksheets each print on one page. If not, go back into the Page Setup dialog box for each worksheet and rescale settings if needed. Press Esc to leave the Print Preview mode.

n. Click the Page Setup Dialog Box Launcher, click the Header/Footer tab in the Page Setup dialog box, click Custom Footer. Click in the left section of the footer and type your name. Click in the center section of the footer and, click Insert Sheet Name. Click in the right section of the footer, click Insert File Name, and then click OK to close the Footer dialog box. Click OK to close the Page Setup dialog box.

o. Right-click the Seating sheet tab and select Ungroup Sheets.

p. Save and close the file. Based on your instructor’s directions, submit e01p3TicketSales_LastFirst.

---

1 Guest House Rental Rates

ANALYSIS CASE

You manage a beach guest house in Ft. Lauderdale containing three types of rental units. Prices are based on peak and off-peak times of the year. You want to calculate the maximum daily revenue for each rental type, assuming all units are rented. In addition, you will calculate the discount rate for off-peak rental times. Finally, you will improve the appearance of the worksheet by applying font, alignment, and number formats.

a. Open e01m1Rentals and save it as e01m1Rentals_LastFirst.

b. Apply the Heading 1 cell style to the range A1:G1 and the 20% - Accent1 cell style to the range A2:G2.

c. Merge and center Peak Rentals in the range C4:D4, over the two columns of peak rental data. Apply Dark Red fill color and White, Background 1 font color.

d. Merge and center Off-Peak Rentals in the range E4:F4 over the three columns of off-peak rental data. Apply Blue fill color and White, Background 1 font color.

e. Center and wrap the headings on row 5. Adjust the width of columns D and F if needed. Center the data in the range B6:B8.

f. Create and copy the following formulas:
   - Calculate the Peak Rentals Maximum Revenue by multiplying the number of units by the peak rental price per day.
   - Calculate the Off-Peak Rentals Maximum Revenue by multiplying the number of units by the off-peak rental price per day.
   - Calculate the Discount rate for the Off-Peak rental price per day. For example, using the peak and off-peak per day values, the studio apartment rents for 75% of its peak rental rate. However, you need to calculate and display the off-peak discount rate, which is 20% for the Studio Apartment. To calculate the discount rate, divide the off-peak per day rate by the peak per day rate. Subtract that result from 1.0, which represents 100%.

---

DISCOVER

A

f. Format the monetary values with Accounting Number Format. Format the Discount Rate formula results in Percent Style with one decimal place. Adjust column widths if necessary to display the data.

g. Apply Blue, Accent 1, Lighter 80% fill color to the range E5:G8.

h. Select the range E5:G5 and apply a custom color with Red 242, Green 220, and Blue 219.

i. Answer the four questions below the worksheet data. If you change any values to answer the questions, change the values back to the original values.

j. Create a copy of the Rental Rates worksheet, place the new sheet to the right side of the original worksheet, and rename the new sheet Formulas. Display cell formulas on the Formulas sheet.

k. Group the worksheets and do the following:
   - Select landscape orientation.
   - Set 1" top, bottom, left, and right margins. Center the data horizontally on the page.
   - Insert a footer with your name on the left side, the sheet name code in the center, and the file name code on the right side.
   - Apply the setting to fit to one page.

l. Click the Formulas sheet tab and set options to print gridlines and headings. Adjust column widths.

m. Save and close the file. Based on your instructor’s directions, submit e01m1Rentals_LastFirst.
You are a small real estate agent in Indianapolis. You track the real estate properties you list for clients. You want to analyze sales for selected properties. Yesterday, you prepared a workbook with a worksheet for recent sales data and another worksheet listing several properties you listed. You want to calculate the number of days that the houses were on the market and their sales percentage of the list price. In one situation, the house was involved in a bidding war between two families that really wanted the house. Therefore, the sale price exceeded the list price.

a. Open e01m2Sales_LastFirst.
b. Delete the row that has incomplete sales data. The owners took their house off the market.
c. Type 2018-001 in cell A5 and use Auto Fill to complete the series to assign a property ID to each property.
d. Calculate the number of days each house was on the market in column C. Copy the formula down that column.
e. Format list prices and sold prices with Accounting Number Format with zero decimal places.
f. Calculate the sales price percentage of the list price in cell H5. The second house was listed for $500,250, but it sold for only $480,125. Therefore, the sale percentage of the list price is 79.99%. Format the percentages with two decimal places.
g. Wrap the headings on row 4.
h. Insert a new column between the Date Sold and List Price columns. Do the following:
   • Move the Days on Market range C:C13 to the new column.
   • Delete the empty column C.
i. Edit the list date of the 413 Chestnut Circle house to be 4/2/2018. Edit the list price of the house on Amsterdam Drive to be $555,000.
j. Select the property rows and set a 25 row height and apply Middle Align.
k. Apply the All Borders border style to the range A4:H12. Adjust column widths as necessary.
l. Apply Align Right and indent twice the values in the range E5:E12.
m. Apply 120% scaling.

o. Delete the Properties worksheet.
p. Use the Select All feature to select all data on the Houses Sold worksheet and copy it to the Formulas worksheet.

q. Complete the following steps on the Formulas worksheet:
   • Hide the Date Listed and Date Sold columns.
   • Display cell formulas.
   • Set options to print gridlines and row and column headings.
   • Adjust column widths.

r. Group the worksheets and do the following:
   • Set landscape orientation.
   • Center the page horizontally and vertically between the margins.
   • Insert a footer with your name on the left side, the sheet tab code in the center, and the file name code on the right side.
s. Save and close the file. Based on your instructor's directions, submit e01m2Sales_LastFirst.
Tip Distribution

You are a server at a restaurant in Portland. You must tip the bartender 13% of each customer's drink sales and the server assistant 1.75% of the food sales plus 2% of the drink sales. To complete a worksheet that shows the tips, salaries, and your net tip. Open e01b15Server and save it as e01b15Server_LastFirst.

Insert a column between the Drinks and Tip Left columns. Type the label Subtotal in cell D6. Calculate the food and drinks subtotal for the first customer and copy the formula down the column. In column F, enter a formula to calculate the amount of the tip as a percentage of the subtotal for the first customer's sales. Format the results with Percent Style with one decimal place. Type 13% in cell G7, type 1.75% in cell H7, and type 2% in cell I7. Copy these percentage values down these three columns. Horizontally center the data in the three percentage columns.

In cell J7, calculate the bartender's tip for the first customer, using the rule specified in the first paragraph. In cell K7, calculate the server assistant's tip for the first customer, using the rule specified in the first paragraph. In cell L7, calculate your salary after giving the bartender and server their shares of the tips. Copy the formulas from the range J7:L7 down their respective columns. Merge and center Customer Subtotal and Tip in the range B5:E5, Tip Rates in the range F5:J5, and Tip Amounts in the range J5:L5. Apply Currency format to the monetary values. Apply borders around the Tip Rates and Tip Amounts sections similar to the existing border around the Customer Subtotal and Tip section. For the range A6:J6, apply Orange, Accent 2. Lighter 40% fill color, center horizontal alignment, and wrap text. Apply Orange, Accent 2. Lighter 80% fill color to the values in the Tip Left column and the My Net Tip column.

Set 0.2" left and right margins, select Landscape orientation, and set the scaling to fit to one page. Include a footer with your name on the left footer, the sheet name code in the center, and file name code on the right side. Copy the worksheet and place the copied worksheet on the right side of the original worksheet. Rename the copied worksheet as Tip Formulas. On the Tip Formulas worksheet, display cell comments, gridlines, print headings, and adjust the column widths. Change the Tips sheet tab color to Orange, Accent 2, and change the Tips Formulas sheet tab color to Orange, Accent 2, Darker 25%. Save and close the file. Based on your instructor's directions, submit e01b15Server_LastFirst.

Capstone Exercise

You are a division manager for a regional hearing-aid company in Cheyenne, Wyoming. Your sales managers travel frequently to some of the offices in the western region. You need to create a travel expense report for your managers to use to record their budgeted and actual expenses for their travel reports. The draft report contains a title, input areas, and a detailed expense area.

Format the Title and Complete the Input Areas

Your first task is to format the title and complete the input area. The input area contains two sections: Standard Inputs that are identical for all travelers and Traveler Inputs that the traveler enters based on his or her trip.

a. Open e01c1Travel and save it as e01c1Travel_LastFirst.

b. Merge and center the title over the range A1:E1 and set the row height for the first row to 40.

c. Apply the Input cell style to the ranges B3:B6, E3:E4, and F6:E7, and then apply the Calculation cell style to cell E5. Part of the borders are removed when you apply these styles.


e. Enter 6/1/2018 in cell E3 for the departure date, 6/5/2018 in cell E4 for the return date, 149 in cell E6 for the hotel rate per night, and 18% in cell E7 for the hotel tax rate.

f. Enter a formula in cell F5 to calculate the number of days between the return date and the departure date.

Insert Formulas

The Detailed Expenses section contains the amount budgeted for the trip, the actual expenses reported by the traveler, percentage of the budget spent on each item, and the actual expense amount went over or under budget. You will insert formulas in this section. Some budgeted amounts are calculated based on the inputs. Other budgeted amounts, such as airfare, are estimates.

a. Enter the amount budgeted for Mileage to/from Airport in cell B22. The amount is based on the mileage rate and rounding to the nearest mile.

b. Enter the amount budgeted for Airport Parking in cell B13. This amount is based on the airport parking daily rate and the number of total days traveling (the number of nights + 1) to include both the departure and return dates. For example, if a person departs on June 1 and returns on June 5, the total number of nights at a hotel is 4, but the total number of days the vehicle is parked at the airport is 5.

c. Enter the amount budgeted for Hotel Accommodations in cell B16. This amount is based on the number of nights, the hotel rate, and the hotel tax rate.

d. Enter the amount budgeted for Meals in cell B17. This amount is based on the daily meal allowance and the total travel days (# of hotel nights + 1).

e. Enter the % of Budget in cell D12. This percentage indicates the percentage of actual expenses to budgeted expenses. Copy the formula to the range D13:D18.

f. Enter the difference between the actual and budgeted expenses in cell E12. Copy the formula to the range E13:E18. If the actual expenses exceeded the budgeted expenses, the result should be positive. If the actual expenses were less than the budgeted expense, the result should be negative, indicating under budget.

Add Rows, Indent Labels, and Move Data

The Detailed Expenses section includes a heading Travel to/from Destination. You want to include two more headings to organize the expenses. Then you will indent the items within each category. Furthermore, you want the monetary columns together, so you will insert cells and move the Over or Under column to the right of the Actual column.

a. Insert a new row 15. Type Destination Expenses in cell A15. Bold the label.


c. Indent twice the labels in the ranges A12:A14, A16:A18, and A20.

d. Select the range D10:D21 and insert cells to shift the selected cells to the right.

e. Cut the range F10:F21 and paste it in the range D10:D21 to move the Over or Under data in the new cells you inserted.

Format the Detailed Expenses Section

You are ready to format the values to improve readability. You will apply Accounting Number Format to the monetary values on the first and total rows, Commas Style to the monetary values in the middle rows, and Percent Style for the percentages.


b. Apply Commas Style to the range B13:D20.

c. Apply Percent Style with one decimal place to the range E12:E20.
d. Underline the **range: B20:D20.** Do not use the border feature.

e. Apply the cell style **Bad** to cell D21 because the traveler went over budget.

f. Select the range A10:E21 and apply **Thick Outside Borders.**

g. Select the range A10:E10, apply **Blue-Gray, Text 2, Lighter 80% fill color,** apply **Center** alignment, and apply **Wrap Text.**

**Manage the Workbook**

You will apply page setup options, insert a footer, and then duplicate the Expenses statement worksheet.

a. Spell-check the workbook and make appropriate corrections.

b. Set a **1.5"** top margin and select the margin setting to center the data horizontally on the page.

c. Insert a footer with your name on the left side, the sheet name code in the center, and the file name code on the right side.

d. Copy the Expenses worksheet, move the new worksheet to the end, and rename it **Formulas.**

e. Display the cell formulas on the Formulas worksheet, change to landscape orientation, and adjust column widths. Use the Page Setup dialog box or the Page Layout tab to print gridlines and row and column headings.

f. Save and close the file. Based on your instructor's directions, submit e01c1Travel_LastFirst.
CASE STUDY | Townsend Mortgage Company

You are an assistant to Erica Matheson, a mortgage broker at the Townsend Mortgage Company. Erica spends her days reviewing mortgage rates and trends, meeting with clients, and preparing paperwork. She relies on your expertise in using Excel to help analyze mortgage data.

Today, Erica provided you with sample mortgage data: loan number, house cost, down payment, mortgage rate, and the length of the loan in years. She asked you to perform some basic calculations so that she can check the output provided by her system to verify if it is calculating results correctly. She wants you to calculate the amount financed, the periodic interest rate, the total number of payment periods, the percent of the house cost that is financed, and the payoff year for each loan. In addition, you will calculate totals, averages, and other basic statistics.

Furthermore, she has asked you to complete another worksheet that uses functions to look up interest rates from a separate table, calculate the monthly payments, and determine how much (if any) the borrower will have to pay for private mortgage insurance (PMI).
Formula Basics

When you increase your understanding of formulas, you can build robust workbooks that perform a variety of calculations for quantitative analysis. Your ability to build sophisticated workbooks and to interpret the results increases your value to any organization. By now, you should be able to build simple formulas using cell references and mathematical operators and use the order of operations to control the sequence of calculations in formulas.

In this section, you will create formulas in which cell addresses change or remain fixed when you copy them.

Using Relative, Absolute, and Mixed Cell References in Formulas

When you copy a formula, Excel either adjusts or preserves the cell references in the copied formula based on how the cell references appear in the original formula. Excel uses three different ways to reference a cell in a formula: relative, absolute, and mixed. Relative references change when a formula is copied. For example, if a formula containing the cell A1 is copied down one row in the column, the reference would become A2. In contrast, absolute references remain constant, no matter where they are copied. Mixed references are a combination of both absolute and relative, where part will change and part will remain constant.

When you create a formula that you will copy to other cells, ask yourself the following question: Do the cell references contain constant or variable values? In other words, should the cell references be adjusted or always refer to the same cell location, regardless of where the copied formula is located?

Use a Relative Cell Reference

A relative cell reference is the default method of referencing in Excel. It indicates a cell’s relative location, such as five rows up and one column to the left, from the original cell containing the formula. When you copy a formula containing a relative cell reference, the cell references in the copied formula change relative to the position of the copied formula. Regardless of where you paste the formula, the cell references in the copied formula maintain the same relative distance from the cell containing the copied formula, as the cell references the relative location to the original formula cell.

In Figure 2.2, the formulas in column F contain relative cell references. When you copy the original formula =D2-E2 from cell F2 down one row to cell F3, the copied formula changes to =D3-E3. Because you copy the formula down the column to cell F3, the column letters in the formula stay the same, but the row numbers change to reflect the row to which you copied the formula. Using relative referencing is an effective time-saving tool. For example, using relative cell addresses to calculate the amount financed ensures that each borrower’s down payment is subtracted from his or her respective house cost.

Use an Absolute Cell Reference

In many calculations there are times in which a value should remain constant, such as an interest rate or payroll date. In these situations absolute cell references are utilized. An absolute cell reference provides a constant reference to a specific cell. When you copy a formula containing an absolute cell reference, the cell reference in the copied formula does not change, regardless of where you copy the formula. An absolute cell reference appears with a dollar sign before both the column letter and row number, such as $B$5.

In Figure 2.3, the down payment is calculated by multiplying the house cost by the down payment rate (15%). Each down payment calculation uses a different purchase price and constant down payment rate. Therefore, an absolute reference is required. Cell E2 contains =$D$2*$B$4 ($300,000*15.0%) to calculate the first borrower’s down payment ($45,000). When you copy the formula down to the next row, the copied formula in cell E3 is =$D$3*$B$4. The relative cell reference D2 changes to D3 (for the next house cost), and the absolute cell reference $B$4 remains the same to refer to the constant 15.0% down payment rate. This formula ensures that the cell reference to the house cost changes for each row but that the house cost is always multiplied by the rate in cell B4.

TIP: INPUT AREA AND ABSOLUTE CELL REFERENCES

To illustrate the effect of modifying an assumption (e.g., the down payment rate changes from 15% to 20%), it is efficient to enter the new input value in only one cell (e.g., B4) rather than including the same value in a string of formulas. In Figure 2.3, values that can be modified, such as the down payment rate, are put in an input area. Generally, formulas use absolute references to the cells in the input area. For example, B4 is an absolute cell reference in all the down payment calculations. If the value in B4 is modified, Excel recalculates the amount of down payment for all the down payment formulas. By using cell references from an input area, you can perform what-if analyses very easily.
When utilizing the fill option to copy a formula, if an error or unexpected result occurs, a good starting point for troubleshooting is checking input values to determine if an absolute or mixed reference is needed. Figure 2.4 shows what happens if the down payment formula used a relative reference to cell B4. If the original formula in cell E2 is =D2*D4, the copied formula becomes =D3*B5 in cell E3. The relative cell reference to B4 changes to B5 when you copy the formula down. Because cell B5 is empty, the $1350,000 house cost in cell D3 is multiplied by 0, giving a $0 down payment, which is not a valid down payment amount.

![FIGURE 2.4 Error in Formula](image)

**Use a Mixed Cell Reference**

A **mixed cell reference** combines an absolute cell reference with a relative cell reference.

When you copy a formula containing a mixed cell reference, either the column letter or the row number that has the absolute reference remains fixed while the other part of the cell reference that is relative changes in the copied formula. SB4 and BS4 are examples of mixed cell references. In the formula $SB4$, the column B is absolute, and the row number is relative: when you copy the formula, the column letter B does not change, but the row number will change. In the reference BS4, the column letter B changes, but the row number, 4, does not change. To create a mixed reference, type the dollar sign to the left of the part of the cell reference you want to be absolute.

In the down payment formula, you can change the formula in cell E2 to be =D2*BS4. Because you are copying down the same column, only the row number 4 must be absolute: the column letter stays the same. Figure 2.5 shows the copied formula =D3*BS4 in cell E3. In situations where you can use either absolute or mixed references, consider using mixed references to shorten the length of the formula.

![FIGURE 2.5 Relative and Mixed Cell References](image)
**Hands-On Exercises**

Skills covered: Use a Relative Cell Reference • Use an Absolute Cell Reference • Use a Mixed Cell Reference

1 Formula Basics

Erica prepared a workbook containing data for five mortgages financed by the Townsend Mortgage Company. The data include house cost, down payment, mortgage rate, number of years to pay off the mortgage, and the financing date for each mortgage.

**STEP 1**

**USE A RELATIVE CELL REFERENCE**

You will calculate the amount financed by each borrower by creating a formula with relative cell references that calculates the difference between the house cost and the down payment. After verifying the results of the amount financed by the first borrower, you will copy the formula down the Amount Financed column to calculate the other borrowers' amounts financed. Refer to Figure 2.6 as you complete Step 1.

![Figure 2.6: Formula Containing Relative Cell Reference Copied](image)

**FIGURE 2.6** Formula Containing Relative Cell Reference Copied

- **a.** Open e02h1Loans and save it as e02h1Loans_LastFirst.

  **TROUBLESHOOTING:** If you make any major mistakes in this exercise, you can close the file, open e02h1Loans again, and then start this exercise over.

  The workbook contains two worksheets: Details (for Hands-On Exercises 1 and 2) and Payment Info (for Hands-On Exercise 3). You will enter formulas in the shaded cells.

- **b.** Click cell D8 in the Details sheet. Type = and click cell B8, the cell containing the first borrower’s house cost.

- **c.** Type - and click cell C8, the cell containing the down payment by the first borrower.

- **d.** Click Enter (the check mark between the Name Box and Formula Bar) to complete the formula.

  The first borrower financed (i.e., borrowed) $320,000, the difference between the cost ($400,000) and the down payment ($80,000).

- **e.** Double-click the cell D8 fill handle.

  You copied the formula down the Amount Financed column for each mortgage row.

- **f.** Click cell D9 and view the formula in the Formula Bar.

  The formula in cell D8 is =B8-C8. The formula copied to cell D9 is =B9-C9. Because the original formula contained relative cell references, when you copy the formula down to the next row, the row numbers for the cell references change. Each result represents the amount financed for that particular borrower.

- **g.** Press and look at the cell references in the formula bar to see how the references change for each formula you copied. Save the workbook with the new formula you created.

**STEP 2**

**USE AN ABSOLUTE CELL REFERENCE**

Column E contains the mortgage rate for each loan. Because the borrowers will make monthly payments, you will modify the given annual interest rate (APR) to a monthly rate by dividing it by 12 (the number of payments in one year) for each borrower. Refer to Figure 2.7 as you complete Step 2.

![Figure 2.7: Formula Containing Incorrect Relative Cell Reference Copied](image)

**FIGURE 2.7** Formula Containing Incorrect Relative Cell Reference Copied

- **a.** Click cell F8.

  You will create a formula to calculate the monthly interest rate for the first borrower.

- **b.** Type =E8/B5 and click Enter (the check mark between the Name Box and the Formula Bar).

  Typically, you should avoid typing values directly in formulas. Therefore, you use a reference to cell B5, where the number of payments per year is placed in the input area, so that the company can change the payment period to bimonthly (24 payments per year) or quarterly (four payments per year) without adjusting the formula.

- **c.** Double-click the cell F8 fill handle, click cell F9, and then view the results (see Figure 2.7).

  An error icon displays to the left of cell F9, which displays #DIV/0, and cell F10 displays #VALUE!.

  The original formula was =E8/B5. Because you copied the formula =E8/B5 down the column, the first copied formula is =E9/B6, and the second copied formula is =E10/B7. Although you want the mortgage rate cell reference (E8) to change (E9, E10, etc.) from row to row, you do not want the divisor (cell B5) to change. You need all formulas to divide by the value stored in cell B5, so you will edit the formula to make B5 an absolute reference.

- **d.** Click Undo in the Quick Access Toolbar to undo the AutoFill process. With F8 as the active cell, click to the right of B5 in the Formula Bar.

- **e.** Press F4 and click Enter (the check mark between the Name Box and the Formula Bar).

  Excel changes the cell reference from B5 to $B$5, making it an absolute cell reference.
Function Basics

An Excel function is a predefined computation that simplifies creating a formula that performs a complex calculation. Excel contains more than 400 functions, which are organized into 14 categories. Table 2.1 lists and describes the primary function categories used in this chapter.

| TABLE 2.1 Function Categories and Descriptions |
|----------------|----------------------------------|
| Category       | Description                      |
| Date & Time    | Provides methods for manipulating data and time values. |
| Financial      | Performs financial calculations, such as payments, rates, present value, and future value. |
| Logical        | Performs logical tests and returns the value of the tests. Includes logical operators for combined tests, such as AND, OR, and NOT. |
| Lookup & Reference | Looks up values, creates links to cells, or provides references to cells in a worksheet. |
| Math & Trig    | Performs standard math and trigonometry calculations. |
| Statistical    | Performs common statistical calculations, such as averages and standard deviations. |

When using functions, you must adhere to correct syntax, the rules that dictate the structure and components required to perform the necessary calculations. Start a function with an equal sign, followed by the function name, and then its arguments enclosed in parentheses.

- The function name describes the purpose of the function. For example, the function name SUM indicates that the function sums, or adds, values.
- A function's arguments specify the inputs—such as cells, values, or arithmetic expressions—that are required to complete the operation. In some cases, a function requires multiple arguments separated by commas.

In this section, you will learn how to insert common functions using the keyboard and the Insert Function and Function Arguments dialog boxes.

Inserting a Function

To insert a function by typing, first type an equal sign, and then begin typing the function name. Formula AutoComplete displays a list of functions and defined names that match letters as you type a formula. For example, if you type =SU, Formula AutoComplete displays a list of functions and names that start with SU (see Figure 2.9). You can double-click the function name from the list or continue typing the function name. You can even point to a list item and see the ScreenTip describing the function.

![FUNCTION AUTOCOMPLETE](image)

**FIGURE 2.9 Formula AutoComplete**
After you type the function name and opening parenthesis, Excel displays the **function ScreenTip**, a small pop-up description that displays the function’s arguments. The argument you are currently entering is bold in the function ScreenTip (see Figure 2.10). Square brackets indicate optional arguments. For example, the SUM function requires the number1 argument, but the number2 argument is optional. Click the argument name in the function ScreenTip to select the actual argument in the formula you are creating if you want to make changes to the argument.

You can also use the Insert Function dialog box to search for a function, select a function category, and select a function from the list (see Figure 2.11). The dialog box is helpful if you want to browse a list of functions, especially if you are not sure of the function you need and want to see descriptions.

To display the Insert Function dialog box, click Insert Function (±) located between the Name Box and the Formula Bar or click Insert Function in the Function Library group on the Formulas tab. From within the dialog box, select a function category, such as Most Recently Used, and select a function to display the syntax and a brief description of that function. Click Help on this function to display details about the selected function.

When you find the function you want, click OK. The Function Arguments dialog box opens so that you can enter the arguments for that specific function (see Figure 2.12). Argument names in bold (such as number1 in the SUM function) are required. Argument names that are not bold (such as number2 in the SUM function) are optional. The function can operate without the optional argument, which is used when you need additional specifications to calculate a result.

**TIP: #NAME?**
If you enter a function and #NAME? displays in the cell, you might have mistyped the function name. To avoid this problem, select the function name from the Formula AutoComplete list as you type the function name, or use the Insert Function dialog box. You can type a function name in lowercase letters. If you type the name correctly, Excel converts the name to all capital letters when you press Enter, indicating that you spelled the function name correctly.

**Inserting Basic Math and Statistics Functions**

Excel includes commonly used math and statistical functions that you can use for a variety of calculations. For example, you can insert functions to calculate the total amount you spend on dining out in a month, the average amount you spend per month purchasing music online, your highest electric bill, and your lowest time to run a mile this week. When using these functions, a change in the values within the ranges referenced will change the results of the function.
Use the SUM Function

The **SUM function** totals values in one or more cells and displays the result in the cell containing the function. This function is more efficient to create when you need to add the values contained in three or more contiguous cells. For example, to add the contents of cells A2 through A14, you could enter =SUM(A2+A3+A4+A5+A6+A7+A8+A9+A10+A11+A12+A13+A14), which is time-consuming and increases the probability of entering an inaccurate cell reference, such as entering a cell reference twice or accidentally leaving out a cell reference. Instead, you should use the SUM function, =SUM(A2:A14).

**TIP: FUNCTION SYNTAX**
In this book, the function syntax lines are highlighted. Brackets [] indicate optional arguments; however, do not actually type the brackets when you enter the argument.

The SUM function contains one required argument (number1) that represents a range of cells to add. The range, such as A2:A14, specifies the first and last of an adjacent group of cells containing values to SUM. Excel will sum all cells within that range. The number 1 optional argument is used when you want to sum values stored in nonadjacent cells or ranges, such as =SUM(A2:A14,F2:F14). The ellipsis in the function syntax indicates that you can add as many additional ranges as desired, separated by commas.

**TIP: AVOIDING FUNCTIONS FOR BASIC FORMULAS**
Do not use a function for a basic mathematical expression. For example, although =SUM(B4/C4) produces the same result as =B4/C4, the SUM function is not needed to perform the basic arithmetic division. Furthermore, someone taking a quick look at that formula might assume it performs addition instead of division. Use the most appropriate, clear-cut formula, =B4/C4.

To insert the SUM function (for example, to sum the values of a range), complete one of the following steps:

- Type =SUM(type the range), and press Enter.
- Type =SUM(shift+drag to select the range, then type the closing]) and press Enter.
- Click a cell, click Sum in the Function Library group on the Formulas tab, press Enter to select the suggested range (or drag to select a range), and then press Enter.
- Click in a cell, click AutoSum in the Function Library group on the Formulas tab, either press Enter to select the suggested range or select Function Library on the Home tab, press Enter to select the suggested range (or drag to select a range), and then press Enter.
- Click the cell directly underneath the range you would like to SUM and press Alt+=.

Figure 2.13 shows the result of using the SUM function in cell D2 to total scores (898).

**TIP: AVOIDING SUMMING ERRORS**
If you perform a calculation on the Home tab or in the Function Library group on the Formulas tab, Excel inserts the SUM function. However, if you click the Sum arrow, Excel displays a list of basic functions to select: Sum, Average, Count Numbers, Max, and Min. If you want to insert another function, select More Functions from the list.

**TIP: SUM ARROW**
If you click Sum in the Editing group on the Home tab or in the Function Library group on the Formulas tab, Excel inserts the SUM function. However, if you click the Sum arrow, Excel displays a list of basic functions to select: Sum, Average, Count Numbers, Max, and Min. If you want to insert another function, select More Functions from the list.

**TIP: NEST FUNCTIONS AS ARGUMENTS**
A nested function occurs when one function is embedded as an argument within another function.

Each function has its own set of arguments that must be included. For example, cell D10 in Figure 2.13 contains =ROUNDDOWN(AVERAGE(A2:A14);2). The ROUNDDOWN function requires two arguments: number (the number to be rounded) and num_digits (the number of decimals to which the number is to be rounded).

The AVERAGE function is used to create the number to be rounded, and is nested in the number arguments of the ROUND function. AVERAGE(A2:A14) returns 81.6366. That value is then rounded to two decimal places, indicated by 2 in the num_digits argument. The result is 81.64. If you change the second argument from 2 to 0, such as =ROUNDDOWN(AVERAGE(A2:A14);0), the result would be 82.

**Use the AVERAGE and MEDIAN Functions**

People often describe data based on central tendency, which means that values tend to cluster around a central value. Excel provides two functions to calculate central tendency: AVERAGE and MEDIAN. The AVERAGE function calculates the arithmetic mean, or average, for the values in a range of cells. You can use this function to calculate the class average on a biology test or the average number of points scored per game by a basketball player. In Figure 2.13, =AVERAGE(A2:A14) in cell D3 returns 81.6366 as the average test score. The AVERAGE function ignores empty cells and cells containing N/A or text.

=AVERAGE (number1, [number2]...)

**STEP 3**

The **MEDIAN function** finds the midpoint value, which is the value that one half of the data set is above or below. The median is particularly useful because extreme values often influence arithmetic mean calculated by the **AVERAGE function**. In Figure 2.13, the two extreme test scores of 50 distort the average. The rest of the test scores range from 80 to 98. Cell D4 contains =MEDIAN(A2:A14). The median for test scores is 86, which indicates that half the test scores are above 86 and half the test scores are below 86. This statistic is more reflective of the data set than the average. The **MEDIAN function** ignores empty cells and cells containing N/A or text.

```excel
=MEDIAN(number1, number2, ...)
```

**STEP 4**

**Use the MIN and MAX Functions**

The **MIN function** analyzes an argument list to determine the lowest value, such as the lowest score on a test. Manually inspecting a range of values to identify the lowest value is inefficient, especially in large spreadsheets. In Figure 2.13, =MIN(A2:A14) in cell D5 identifies that 50 is the lowest test score.

```excel
=MIN(number1, number2, ...)
```

The **MAX function** analyzes an argument list to determine the highest value, such as the highest score on a test. In Figure 2.13, =MAX(A2:A14) in cell D6 identifies 98 as the highest test score.

```excel
=MAX(number1, number2, ...)
```

**TIP: NONADJACENT RANGES**

In most basic aggregate functions such as **SUM**, **MIN**, **MAX**, and **AVERAGE**, you can use multiple ranges as arguments, such as finding the largest number within two nonadjacent (nonconsecutive) ranges. For example, you can find the highest test score where some scores are stored in cells A2:A14 and others are stored in cells C2:C14. Separate each range with a comma in the argument list, so that the formula is =MAX(A2:A14,C2:C14).

**Use the COUNT Functions**

Excel provides three basic count functions—**COUNT**, **COUNTBLANK**, and **COUNTA**—to count the cells in a range that meet a particular criterion. The **COUNT function** tallies the number of cells in a range that contain values you can use in calculations, such as numerical and date data, but excludes blank cells or text entries from the tally. In Figure 2.13, the selected range spans 13 cells; however, =COUNT(A2:A14) in cell D7 returns 11, the number of cells that contain numerical data. It does not count the cell containing the text N/A or the blank cell.

The **COUNTBLANK function** tallies the number of cells in a range that are blank. In Figure 2.13, =COUNTBLANK(A2:A14) in cell D8 identifies that one cell in the range A2:A14 is blank. The **COUNTA function** tallies the number of cells in a range that are not blank, that is, cells that contain data, whether a value, text, or a formula. In Figure 2.13, =COUNTA(A2:A14) in cell D9 returns 12, indicating that the range A2:A14 contains 12 cells that contain some form of data. It does not count the blank cell; however, it will count cells that contain text such as cell A6.

```excel
=COUNT(value1, value2, ...)
```

```excel
=COUNTBLANK(range)
```

```excel
=COUNTA(value1, value2, ...)
```

**TIP: STATUS BAR STATISTICS: AVERAGE, COUNT, AND SUM**

When you select a range of cells containing values, by default Excel displays the average, count, and sum of those values on the status bar. You can customize the status bar to show other selection statistics, such as the minimum and maximum values for a selected range. To display or hide particular selection statistics, right-click the status bar and select the statistic.

**Perform Calculations with Quick Analysis Tools**

**Quick Analysis** is a set of analytical tools you can use to apply formatting, create charts or tables, and insert basic functions. When you select a range of data, the Quick Analysis button displays adjacent to the bottom-right corner of the selected range. Click the Quick Analysis button to display the Quick Analysis gallery and select the analytical tool to meet your needs.

Figure 2.13 shows the Totals gallery options so that you can sum, average, or count the values in the selected range. Select % Total to display the percentage of the grand total of two or more columns. Select Running Total to provide a cumulative total at the bottom of multiple columns. Additional options can be seen by clicking the right expansion arrow.

**TIP: ROUND VersUS DECREASE DECIMAL POINTS**

When you click Decrease Decimal in the Number group to display fewer or no digits after a decimal point, Excel still stores the original value's decimal places so that those digits can be used in calculations. The **ROUND** function changes the stored value to a specified number of decimal places.

**Using Date Functions**

In order to maximize the use of dates and date functions in Excel, it is important to understand how they are handled in the program. Excel assigns serial numbers to dates. The date January 1, 1900 is the equivalent to the number 1. The number 2 is the equivalent of January 2, 1900 and so on. Basically, Excel adds 1 to every serial number as each day passes. Therefore the newer the date, the bigger the equivalent serial number. For example, assume today is January 1, 2018, and you graduate on May 6, 2018. To determine how many days until graduation, subtract today's date from the graduation date. Excel uses the serial numbers for these dates (43101 and 43226) to calculate the difference of 125 days.

**Insert the TODAY Function**

The **TODAY function** displays the current date in a cell. Excel updates the TODAY function results when you open or print the workbook. The TODAY function does not require arguments, but you must include the parentheses. If you omit the parentheses, Excel displays #NAME? in the cell with a green triangle in the top-left corner of the cell. When you click the cell, an error icon appears that you can click for more information.

```excel
=TODAY()
```

**Insert the NOW Function**

The **NOW function** uses the computer's clock to display the current date and military time that you last opened the workbook. (Military time expresses time on a 24-hour period where 1:00 is 1 a.m. and 13:00 is 1 p.m.) The date and time will change every time the workbook is opened. Like the TODAY function, the NOW function does not require arguments, but you must include the parentheses. Omitting the parentheses creates a #NAME? error.

```excel
=NOW()
```
4. What visual features help guide you through typing a function directly in a cell? p. 162
5. What type of data do you enter in a Function Arguments dialog box, and what are four things the dialog box tells you? p. 163
6. What is the difference between the AVERAGE and MEDIAN functions? pp. 165–166
7. What is a nested function, and why would you create one? p. 165

Skills covered: Insert a Function • Insert a Function Using Formula AutoComplete • Use the Insert Function Dialog Box • Use the SUM Function • Use the AVERAGE and MEDIAN Functions • Use the MIN and MAX Functions • Use the COUNT Functions • Use the TODAY Function

2 Function Basics
The Townsend Mortgage Company worksheet contains an area in which you will enter summary statistics. In addition, you will include the current date.

Step 1
Use the SUM Function
The first summary statistic you calculate is the total value of the houses bought by the borrowers. You will use the SUM function. Refer to Figure 2.14 as you complete Step 1.

---

a. Open e02h1Loans_LastFirst if you closed it at the end of Hands-On Exercise 1 and save it as e02h2Loans_LastFirst, changing h1 to h2.

b. Ensure that the Details worksheet is active and click cell B16, the cell where you will enter a formula for the total house cost.

c. Click AutoSum Σ in the Editing group on the Home tab.

Excel anticipates the range of cells containing values you want to sum based on where you enter the formula—in this case, A8:B12. This is not the correct range, so you must enter the correct range.
USE THE MEDIAN FUNCTION

You realize that extreme house costs may distort the average. Therefore, you decide to identify the median house cost to compare it to the average house cost. Refer to Figure 2.16 as you complete Step 3.

- **Step 1:** MEDIAN function in Formula Bar
- **Step 2:** Click Insert function
- **Step 3:** Click to expand Function Arguments dialog box again
- **Step 4:** MEDIAN function being entered in this cell

**FIGURE 2.16 MEDIAN Function Calculates the Median House Cost**

- **a.** Ensure that cell B18 is the active cell. Click **Insert Function** between the Name Box and the Formula Bar, or in the Function Library group on the Formulas tab.
  The Insert Function dialog box opens. Use this dialog box to select the MEDIAN function because it is not available on the Ribbon.
- **b.** Type median in the Search for a function box and click **Go**.
  Excel displays a list of functions in the Select a function list. The MEDIAN function is selected at the top of the list; the bottom of the dialog box displays the syntax and the description.
- **c.** Read the MEDIAN function description and click **OK**.
  The Function Arguments dialog box opens. It contains one required argument, Number 1, representing a range of cells containing values. It has an optional argument, Number 2, which you can use if you have nonadjacent ranges that contain values.
- **d.** Click **Collapse Dialog Box** to the right of the Number 1 box.
  You collapsed the Function Arguments dialog box so that you can select the range.
- **e.** Select the range B8:B12 and click **Expand Dialog Box** in the Function Arguments dialog box.
  The Function Arguments dialog box expands, displaying B8:B12 in the Number 1 box.

**STEP 3**

**USE THE AVERAGE FUNCTION**

Before copying the functions to calculate the total down payments and amounts financed, you want to calculate the average house cost of the houses bought by the borrowers in your list. Refer to Figure 2.15 as you complete Step 2.

**FIGURE 2.15 AVERAGE Function Calculates Average House Cost**

- **a.** Click the **Formulas tab** and click **cell B17**, the cell where you will display the average cost of the houses.
- **b.** Click the **AutoSum arrow** in the Function Library group and select **Average**.
  Excel selects cell B16, which is the total cost of the houses. You need to change the range.
- **c.** Select the range **B8:B12**, the cells containing the house costs.
  The function is =AVERAGE(B8:B12).
- **d.** Press **Enter**, making cell B18 the active cell.
  The average house cost is $304,240.
- **e.** Save the workbook.
f. Click OK to accept the function arguments and close the dialog box. Half of the houses purchased cost more than the median, $329,750, and half of the houses cost less than this value. Notice the difference between the median and the average: The average is lower because it is affected by the lowest-priced house, $175,500.

g. Save the workbook.

**STEP 4 >> USE THE MIN, MAX, AND COUNT FUNCTIONS**

Erica wants to know the least and most expensive houses so that she can analyze typical customers of the Townsend Mortgage Company. You will use the MIN and MAX functions to obtain these statistics. In addition, you will use the COUNT function to tally the number of mortgages in the sample. Refer to Figure 2.17 as you complete Step 4.

![Figure 2.17 MIN, MAX, and COUNT Function Results](image)

**FIGURE 2.17 MIN, MAX, and COUNT Function Results**

a. Click cell B19, the cell to display the cost of the least expensive house.

b. Click the AutoSum arrow in the Function Library group, select Min, select the range B8:B12, and then press Enter.

The MIN function identifies that the least expensive house is $175,500.

c. Click cell B20. Click the AutoSum arrow in the Function Library group, select Max, select the range B8:B12, and then press Enter.

The MAX function identifies that the highest-costing house is $400,000.

d. Click cell B21. Type =COUNT(B8:B12) and press Enter.

As you type the letter C, Formula AutoComplete suggests functions starting with C. As you continue typing, the list of functions narrows. After you type the beginning parenthesis, Excel displays the function ScreenTip, indicating the arguments for the function. The range B8:B12 contains five cells.

e. Select the range B16:B21.

You want to select the range of original statistics to copy the cells all at one time to the next two columns.

**STEP 5 >> USE THE TODAY FUNCTION**

Before finalizing the worksheet you will insert the current date. You will use the TODAY function to display the current date. Refer to Figure 2.18 as you complete Step 5.

![Figure 2.18 Insert the Current Date with the TODAY Function](image)

**FIGURE 2.18 Insert the Current Date with the TODAY Function**

a. Click cell B4. The cell to contain the current date.

b. Click Date & Time in the Function Library group, select TODAY to display the Function Arguments dialog box, and then click OK to close the dialog box.

The Function Arguments dialog box opens, although no arguments are necessary for this function. Excel displays TODAY() in the Edit formula bar, and inserts the current date in Short Date format, such as 6/1/2018, based on the computer system's date.

c. Click the Format arrow from the Cells group and select AutoFit Column Width.

d. Save the workbook. Keep the workbook open if you plan to continue with the next Hands-On Exercise. If not, close the workbook and exit Excel.
Design the Logical Test

The first argument for the IF function is the logical test. The logical test contains either a value or an expression that evaluates to true or false. The logical test requires a comparison between at least two variables, such as the values stored in cells E2 and B2. In this example, a salesperson receives a bonus if he or she sells more than $10,000 quota. The variable of total sales is in cell E2 and the constant of the sales quota is in cell B2. Therefore, the logical test IF E2 > B2 translates into the following: if the amount of sales generated is greater than $10,000. Table 2.2 lists and describes in more detail the logical operators to make the comparison in the logical test.

In Figure 2.19, cell F2 contains an IF function where the logical test is E2>$B$2 to determine if Tiffany’s sales in cell E2 are greater than the sales goal in cell B2. Copying the function down the column will compare each sales representative’s sales with the $10,000 value in cell B2.

### TABLE 2.2 Comparison Operators

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>=</td>
<td>Equal to</td>
</tr>
<tr>
<td>&lt;&gt;</td>
<td>Not equal to</td>
</tr>
<tr>
<td>&lt;</td>
<td>Less than</td>
</tr>
<tr>
<td>&gt;</td>
<td>Greater than</td>
</tr>
<tr>
<td>&lt;=</td>
<td>Less than or equal to</td>
</tr>
<tr>
<td>&gt;=</td>
<td>Greater than or equal to</td>
</tr>
</tbody>
</table>

Design the Value If True and Value If False Arguments

The second and third arguments of an IF function are value_if_true and value_if_false. When Excel evaluates the logical test, the result is either true or false. If the logical test is true, the value_if_true argument executes. If the logical test is false, the value_if_false argument executes. Only one of the last two arguments is executed; both arguments cannot be executed, because the logical test is either true or false but not both.

The value_if_true and value_if_false arguments can contain text, cell references, formulas, or constants. In Figure 2.19, cell F2 contains an IF function in which the value_if_true argument is B3 and the value_if_false argument is 0. Because the logical test (E2>$B$2) is true—that is, Tiffany’s sales of $11,000 are greater than the $10,000 goal—the value_if_true argument is executed, and the result displays $500, the value that is stored in cell B3.

Jose’s sales of $10,000 are not greater than $10,000, and Rex’s sales of $9,000 are not greater than $10,000. Therefore, the value_if_false argument is executed and returns no bonus in cells F3 and F4.

### TIP: AT LEAST TWO POSSIBLE RIGHT ANSWERS

Every IF function can have at least two right solutions to produce the same results. Since the logical test is a comparative expression, it can be written two ways. For example, comparing whether E2 is greater than B2 can be written using greater than (E2>B2) or the reverse can also be compared to see if B2 is less than E2 (B2<E2). Depending on the logical test, the value if true and value if false arguments will switch.

Figure 2.21 illustrates several IF functions, how they are evaluated, and their results. The input area contains values that are used in the logical tests and results. You can create this worksheet with the input area and IF functions to develop your understanding of how IF functions work.
• **Cell A9.** The logical test A2=A3 compares the values in cells A2 and A3 to see if they are equal. Because $1,000 is not equal to $2,000, the logical test is false. The value_if_false argument is executed, which displays $5, the value stored in cell A5.

• **Cell A10.** The logical test A2<A3 determines if the value in cell A2 is less than the value in A3. Because $1,000 is less than $2,000, the logical test is true. The value_if_true argument is executed, which displays the value stored in cell A4, which is 10%.

• **Cell A11.** The logical test A2>C>A3 determines if the values in cells A2 and A3 are not equal. Because $1,000 and $2,000 are not equal, the logical test is true. The value_if_true argument is executed, which displays the text 'Not Equal'.

• **Cell A12.** The logical test A2>A3 is false. The value_if_false argument is executed, which multiplies the value in cell A2 ($1,000) by the value in cell A5 (5%) and displays $50. The parentheses in the value_if_true (A2*A4) and value_if_false (A2*A5) arguments are optional. They are not required but may help you read the function arguments better.

• **Cell A13.** The logical test A2>A3 is false. The value_if_false argument, which contains a nested MAX function, is executed. The MAX function, MAX(A2*A5,A6), multiplies the values in cells A2 ($1,000) and A5 (5%) and returns the higher of the product ($50) and the value stored in cell A6 ($250).

• **Cell A14.** The logical test A2<A4=A3*A5 is true. The contents of cell A2 ($1,000) are multiplied by the contents of cell A4 (10%) for a result of $100. That result is then compared to the result of A3*A5, which is also $100. Because the logical test is true, the function returns the value of cell A6 ($250).

### Using Lookup Functions

You can use lookup and reference functions to quickly find data associated with a specified value. For example, when you order merchandise on a website, the webserver looks up the shipping costs based on weight and distance; or at the end of a semester, your professor uses your average, such as 88%, to look up the letter grade to assign, such as B+.

There are numerous lookup functions in Excel, including VLOOKUP, INDEX, LOOKUP, MATCH, and VLOOKUP. Each lookup function can be used to identify and return information based, in part, on how the data is organized.

#### Use the VLOOKUP function

The VLOOKUP function accepts a value and looks for the value in the left column of a specified table array and returns another value located in the same row from a specified column. Use VLOOKUP to search for exact matches or for the nearest value that is less than or equal to the search value, such as assigning a B grade for a class average between 80% and 89%. The VLOOKUP function has the following three required arguments and one optional argument: (1) lookup_value, (2) table_array, (3) col_index_num, and (4) range_lookup.

=VLOOKUP(lookup_value, table_array, col_index_num, range_lookup)

Figure 2.22 shows a partial grade book that contains a vertical lookup table, as well as the final scores and letter grades. The function in cell F1 is =VLOOKUP(E3,SA51:S857,2).

### TIP: USING VALUES IN FORMULAS

You know to avoid using values in formulas because the input values in a worksheet cell might change. However, as shown in Figure 2.22, the value 2 is used in the col_index_num argument of the VLOOKUP function. The 2 refers to a particular column within the lookup table and is an acceptable use of a number within a formula.
The last argument in the VLOOKUP function is the optional range_lookup. This argument determines how the VLOOKUP function handles lookup values that are not an exact match for the data in the lookup table. By default, range_lookup is set to TRUE, which is appropriate to look up values in a range. Omitting the optional argument or typing TRUE in it enables the VLOOKUP function to find the nearest value that is less than or equal in the table to the lookup value. For this reason, the first column in a VLOOKUP table array should be sorted from smallest to largest (or A to Z alphabetically) when defaulting to TRUE.

To look up an exact match, enter FALSE in the range_lookup argument. For example, if you are looking up product numbers, you must find an exact match to display the price. The function would look like this: =VLOOKUP(D15,SA$1:SA$5,2,FALSE). The function returns a value for the first lookup value that matches the first column of the lookup table. If no exact match is found, the function returns #N/A.

Here is how the VLOOKUP function works:

1. The first argument of the function evaluates the value to be located in the left column of lookup table.
2. Excel searches the first column of the lookup table until it finds there is a result (if possible) or (b) identifies the correct range if an exact match is not required.
3. If Excel finds an exact match, it moves across the table to the column designated by the column index number on that same row, and returns the value stored in that cell. If the last argument is TRUE or omitted, then Excel is looking for an approximate value (NOT an exact value). In this example, if the lookup value is larger than the first number in the first column of the table, it looks to the next value to see if the lookup value is larger and will continue to do so until reaching the largest number in the column. When Excel detects that the lookup value is not greater than the next breakpoint, it stays on that row. Then it uses the column index number to identify the column containing the value to return for the lookup value. Because Excel goes sequentially through the breakpoint values, it is mandatory that the first column values are arranged from the lowest value to the highest value for ranges when the range_lookup argument is TRUE or omitted.

In Figure 2.22, the VLOOKUP function assigns letter grades based on final scores. Excel identifies the lookup value (85 in cell F3) and compares it to the values in the first column of the lookup table (range A3:B7). The last argument is omitted, so Excel tries to find an exact match of 85 or an approximate match; and because the table contains breakpoints rather than every conceivable score and the first column of the lookup table is arranged from the lowest to the highest breakpoints. Excel detects that 85 is greater than 80 but is not greater than 90. Therefore, it stays on the 80 row. Excel looks at the second column (column index number of 2) and returns the letter grade of B. The B grade is then displayed in cell F3.

Create the Lookup Table

A lookup table is a range containing a table of values and text from which data can be retrieved. The table should contain at least two rows and two columns, not including headings. Figure 2.23 illustrates a college directory with three columns. The first column contains professors’ names. You look up a professor’s name in the first column to see his or her office (second column) and phone extension (third column).

FIGURE 2.23 College Directory Lookup Table Analogy

It is important to plan the table so that it conforms to the way in which Excel can utilize the data in it. Excel cannot interpret the structure of Table 2.3. If the values you look up are exact values, you can arrange the first column in any logical order. However, to look up an approximate value in a range (such as the range 80–89%), you must arrange the data from the lowest to the highest value and include only the lowest value in the range (such as 80) instead of the complete range (as demonstrated in Table 2.3). The lowest value for a category or in a series is the breakpoint. Table 2.4 shows how to construct the lookup table in Excel. The first column contains the breakpoints—such as 60, 70, 80, and 90—or the lowest values to achieve a particular grade. The lookup table contains one or more additional columns of related data to retrieve.

### TABLE 2.3 Grading Scale

<table>
<thead>
<tr>
<th>Range</th>
<th>Grade</th>
</tr>
</thead>
<tbody>
<tr>
<td>90–100</td>
<td>A</td>
</tr>
<tr>
<td>80–89</td>
<td>B</td>
</tr>
<tr>
<td>70–79</td>
<td>C</td>
</tr>
<tr>
<td>60–69</td>
<td>D</td>
</tr>
<tr>
<td>Below 60</td>
<td>F</td>
</tr>
</tbody>
</table>

### TABLE 2.4 Grades Lookup Table

<table>
<thead>
<tr>
<th>Range</th>
<th>Grade</th>
</tr>
</thead>
<tbody>
<tr>
<td>90</td>
<td>A</td>
</tr>
<tr>
<td>80</td>
<td>B</td>
</tr>
<tr>
<td>70</td>
<td>C</td>
</tr>
<tr>
<td>60</td>
<td>D</td>
</tr>
<tr>
<td>Below 60</td>
<td>F</td>
</tr>
</tbody>
</table>

You can nest functions as arguments inside the VLOOKUP function. For example, Figure 2.24 illustrates shipping amounts that are based on weight and location (Boston or Chicago). In the VLOOKUP function in cell C3, the lookup_value argument looks up the weight of a package in cell A3. That weight (14 pounds) is compared to the data in the table array argument, which is $E$S$5:$G$5. To determine which column of the lookup table to use, an IF function is nested as the column_index_number argument. The nested IF function compares the city stored in cell B3 to the text Boston. If cell B3 contains Boston, it returns 2 to use as the column_index_number to identify the shipping value for a package that is going to Boston. If cell B3 does not contain Boston (i.e., the only other city in this example is Chicago), the column_index_number is 3.

FIGURE 2.24 IF Function Nested in VLOOKUP Function
Use the HLOOKUP Function

Lookup functions are not limited to only vertical tables. In situations in which data is better organized horizontally, you can design a lookup table where the first row contains the values for the basis of the lookup or the breakpoints, and additional rows contain data to be retrieved. With a horizontal lookup table, use the HLOOKUP function. Table 2.5 shows how quarterly sales data would look in a horizontal lookup table.

<table>
<thead>
<tr>
<th>Region</th>
<th>Qtr1</th>
<th>Qtr2</th>
<th>Qtr3</th>
<th>Qtr4</th>
</tr>
</thead>
<tbody>
<tr>
<td>North</td>
<td>3495</td>
<td>4665</td>
<td>4982</td>
<td>5010</td>
</tr>
<tr>
<td>South</td>
<td>8044</td>
<td>7692</td>
<td>7812</td>
<td>6252</td>
</tr>
<tr>
<td>East</td>
<td>5081</td>
<td>6089</td>
<td>5982</td>
<td>6500</td>
</tr>
<tr>
<td>West</td>
<td>4278</td>
<td>4350</td>
<td>4387</td>
<td>7857</td>
</tr>
</tbody>
</table>

The syntax is almost the same as the syntax for the VLOOKUP function, except the third argument is row_index_num instead of col_index_num.

HLOOKUP(lookup_value, table_array, row_index_num, [range_lookup])

Calculating Payments with the PMT Function

Excel contains several financial functions to help you perform calculations with monetary values. If you take out a loan to purchase a car, you need to know the monthly payment, which depends on the price of the car, the down payment, and the terms of the loan, in order to determine if you can afford the car. The decision is made easier by developing the worksheet in Figure 2.25 and by changing the various input values as indicated.

<table>
<thead>
<tr>
<th>Car Loan Worksheet</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
</tr>
<tr>
<td>2</td>
</tr>
<tr>
<td>3</td>
</tr>
<tr>
<td>4</td>
</tr>
<tr>
<td>5</td>
</tr>
<tr>
<td>6</td>
</tr>
<tr>
<td>7</td>
</tr>
<tr>
<td>8</td>
</tr>
<tr>
<td>9</td>
</tr>
<tr>
<td>10</td>
</tr>
</tbody>
</table>

Creating a loan model helps you evaluate options. You realize that the purchase of a $25,999 car is prohibitive because the monthly payment is $182.01. Purchasing a less expensive car, coming up with a substantial down payment, taking out a longer-term loan, or finding a better interest rate can decrease your monthly payments.
Hands-On Exercises

Skills covered: Use the VLOOKUP function • Use the PMT function • Use the IF function

3 Logical, Lookup, and Financial Functions

Erica wants you to complete another model that she might use for future mortgage data analysis. As you study the model, you realize you need to incorporate logical, lookup, and financial functions.

**STEP 1** USE THE VLOOKUP FUNCTION

Rates vary based on the number of years to pay off the loan. Erica created a lookup table for three common mortgage years, and she entered the current APR. The lookup table will provide efficiency later when the rates change. You will use the VLOOKUP function to display the correct rate for each customer based on the number of years of the respective loans. Refer to Figure 2.26 as you complete Step 1.

![Figure 2.26 VLOOKUP Function to Determine APR](image)

- a. Open e02h2Loans_LastFirst if you closed it at the end of Hands-On Exercise 2 and save it as e02h3Loans_LastFirst, changing h2 to h3.
- b. Click the Payment Info worksheet tab to display the worksheet containing the data to complete. Click cell G9, the cell that will store the APR for the first customer.
- c. Click the Formulas tab, click Lookup & Reference in the Function Library group, and then select VLOOKUP.
- d. Ensure that the insertion point is in the Lookup_value box, click the Collapse Dialog Box, click cell F9 to enter F9 in the Lookup_value box, and then click the Expand Dialog Box to return to Function Arguments dialog box.
- e. Press Tab, click Collapse Dialog Box to the right of the Table_array box, select the range D4:E6, and then click Expand Dialog Box to return to the Function Arguments dialog box.
- f. This is the range that contains that data for the lookup table. The Years values in the table are arranged from lowest to highest. Do not select the column labels for the range.
- g. Anticipate what will happen if you copy the formula down the column. What do you need to do to ensure that the cell references always point to the exact location of the table? If your answer is to make the table array cell references absolute, then you answered correctly.
- h. Press F4 to make the range references absolute.
- i. Press Tab and type 2 in the Col_index_num box.
- j. The second column of the lookup table contains the Rates that you want to return and display in the cells containing the formulas.
- k. Press Tab and type False in the Range_lookup box.
- l. To ensure an exact match to look up in the table, you enter False in the optional argument.
- m. Click OK.

The VLOOKUP function uses the first loan's term in years (2.5) to find an exact match in the first column of the lookup table, and then returns the corresponding rate from the second column, which is 3.625%.

- n. Copy the formula down the columns.
- o. Spot-check the results to make sure the function returned the correct APR based on the number of years.
- p. Save the workbook.
**STEP 2 USE THE PMT FUNCTION**

The worksheet now has all the necessary data for you to calculate the monthly payment for each loan: the APR, the number of years for the loan, the number of payment periods in one year, and the initial loan amount. You will use the PMT function to calculate the monthly payment, which includes paying back the principal amount with interest. This calculation does not include escrow amounts, such as property taxes or insurance. Refer to Figure 2.27 as you complete Step 2.

![Figure 2.27 PMT Function to Calculate Monthly Payment](image)

a. Click cell H9, the cell that will store the payment for the first customer.

b. Click **Financial** in the Function Library group, scroll through the list, and then select **PMT**.

   The Function Arguments dialog box opens.

**TROUBLESHOOTING:** Make sure you select **PMT**, not **PPMT**. The **PMT** function calculates the principal portion of a particular monthly payment, not the total monthly payment itself.

c. Type G9/B6 in the Rate box.

   Think about what will happen if you copy the formula. The argument will be G10/B6 for the next customer. Are those cell references correct? G10 does contain the APR for the next customer, but B6 does not contain the correct number of payments in one year. Therefore, you need to make B5 an absolute cell reference because the number of payments per year does not vary.

d. Press F4 to make the reference to cell B5 absolute.

e. Press Tab and type E9*$B$5 in the Nper box.

   You calculate the nper by multiplying the number of years by the number of payments in one year. You must make B5 an absolute cell reference so that it does not change when you copy the formula down the column.

f. Press Tab and type D9 in the Pv box.

**FIGURE 2.28 IF Function to Calculate Monthly PMI**

a. Click cell F9, the cell that will store the PML if any, for the first customer.

b. Click **Logical** in the Function Library group and select **IF**.

   The Function Arguments dialog box opens. You will enter the three arguments.

c. Type E9=$B$5 in the Logical_test box.

   The logical test compares the down payment percentage to see if the customer’s down payment is at least 20%, the threshold stored in B7, of the amount financed. The customer’s percentage cell reference is relative so that it will change when you copy it down the column; however, cell B7 must be absolute because it contains a value that should remain constant when the formula is copied to other cells.

d. Press Tab and type 0 in the Value_if_true box.
If the customer makes a down payment that is at least 20% of the purchase price, the customer does not pay PMI, so a value of 0 will display whenever the logical test is true. The first customer paid 20% of the purchase price, so he or she does not have to pay PMI.

e. Press Tab and type D9*SBS6/$BS$5 in the Value_if_false box.

If the logical test is false, the customer must pay PMI, which is calculated by multiplying the amount financed (D9) by the periodic PMI rate (the result of dividing the yearly PMI (B6) by the number of payments per year (B5)).

f. Click OK and copy the formula down the column.

The first, second, and fifth customers paid 20% of the purchase price, so they do not have to pay PMI. The third and fourth customers must pay PMI because their respective down payments were less than 20% of the purchase price.

TROUBLESHOOTING: If the results are not as you expected, check the logical operators. People often mistype < and > or forget to type = for >= situations. Correct any errors in the original formula and copy the formula again.

g. Set the worksheets to print on one page. Add a footer with your name on the left, sheet code in the middle, and the file name code on the right.

h. Save and close the file. Based on your instructor’s directions, submit e12h1Loans_LastFirst.

Chapter Objectives Review

After reading this chapter, you have accomplished the following objectives:

1. Use relative, absolute, and mixed cell references in formulas.
   - Use a relative cell address: A relative reference indicates a cell’s location relative to the formula cell. When you copy the formula, the relative cell reference changes.
   - Use an absolute cell reference: An absolute reference is a permanent pointer to a particular cell, indicated with $ before the column letter and the row number, such as $B$5. When you copy the formula, the absolute cell reference does not change.
   - Use a mixed cell reference: A mixed reference contains part absolute and part relative reference, such as $B$5 or BS$5. Either the column or the row reference changes, while the other remains constant when you copy the formula.

2. Insert a function.
   - A function is a predefined formula that performs a calculation. It contains the function name and arguments. Formula AutoComplete, function ScreenTips, and the Insert Function dialog box help you select and create functions. The Function Arguments dialog box guides you through the entering requirements for each argument.

3. Insert basic math and statistics functions.
   - Use the SUM function: The SUM function calculates the total of a range of values. The syntax is =SUM(number1, [number2], ...).
   - Use the AVERAGE and MEDIAN functions: The AVERAGE function calculates the arithmetic mean of values in a range. The MEDIAN function identifies the midpoint value in a set of values.
   - Use the MIN and MAX functions: The MIN function identifies the lowest value in a range, whereas the MAX function identifies the highest value in a range.
   - Use the COUNT functions: The COUNT function tallies the number of cells in a range, that contain values. Whereas the COUNTBLANK function tallies the number of blank cells in a range, and COUNTA tallies the number of cells that are not empty.

4. Use date functions.
   - Insert the TODAY function: The TODAY function displays the current date.
   - Insert the NOW function: The NOW function displays the current date and time.

5. Determine results with the IF function.
   - Design the logical test: The IF function is a logical function that evaluates a logical test using logical operators, such as <, >, and =, and returns one value if the condition is true and another value if the condition is false.
   - Design the value_if_true and value_if_false arguments: The arguments can contain cell references, text, or calculations. If a logical test is true, Excel executes the value_if_true argument. If a logical test is false, Excel executes the value_if_false argument.

   • You can nest or embed other functions inside one or more of the arguments of an IF function to create more complex formulas.

6. Use lookup functions.
   - Use the VLOOKUP function: The VLOOKUP function contains the required arguments lookup_value, table_array, and col_index_num and one optional argument, range_lookup.
   - Create the lookup table: Design the lookup table using exact values or the breakpoints for ranges. If using breakpoints, the breakpoints must be in ascending order.
   - Use the HLOOKUP function: The HLOOKUP function looks up values by row (horizontally) rather than by column (vertically).

7. Calculate payments with the PMT function.
   - The PMT function calculates periodic payments for a loan with a fixed interest rate and a fixed term. The PMT function requires the periodic interest rate, the total number of payment periods, and the original value of the loan.
1. **A set of rules that governs the structure and components for properly entering a function.** p. 161

2. **Displays the current date.** p. 167

3. **Indicates a cell's specific location; the cell reference does not change when you copy the formula.** p. 155

4. **An input, such as a cell reference or value, needed to complete a function.** p. 161

5. **Identifies the highest value in a range.** p. 166

6. **Tallies the number of cells in a range that contain values.** p. 166

7. **Looks up a value in a vertical lookup table and returns a related result from the lookup table.** p. 177

8. **A range that contains data for the basis of the lookup and data to be retrieved.** p. 178

9. **Calculates the arithmetic mean, or average, of values in a range.** p. 165

10. **Identifies the midpoint value in a set of values.** p. 166

11. **Displays the current date and time.** p. 167

12. **Evaluates a condition and returns one value if the condition is true and a different value if the condition is false.** p. 174

13. **Calculates the total of values contained in one or more cells.** p. 164

14. **Calculates the periodic payment for a loan with a fixed interest rate and fixed term.** p. 181

15. **Indicates a cell's location from the cell containing the formula; the cell reference changes when the formula is copied.** p. 154

16. **Contains both an absolute and a relative cell reference in a formula; the absolute part does not change but the relative part does when you copy the formula.** p. 156

17. **An expression that evaluates to true or false.** p. 175

18. **Displays the lowest value in a range.** p. 166

1. If cell E15 contains the formula =S$C$5*F$15, what type of cell reference is the $S$15 in the formula?
   - Relative reference
   - Absolute reference
   - Mixed reference
   - Syntax

2. What function would most efficiently accomplish the same thing as =SUM(B5:F5)/5
   - =SUM(B5:F5)/5
   - =AVERAGE(B5:F5)
   - =MEDIAN(B5:F5)
   - =COUNT(B5:F5)

3. When you start to type =AV, what feature displays a list of functions and defined names?
   - Function ScreenTip
   - Formula AutoComplete
   - Insert Function dialog box
   - Function Arguments dialog box

4. A formula containing the entry =$B$3 is copied to a cell one column to the right and two rows down. How will the entry appear in its new location?
   - =$B$3
   - =$B$5
   - =$C$3
   - =$F$5

5. Which of the following functions should be used to insert the current date and time in a cell?
   - =TODAY()
   - =CURRENT()
   - =NOWNOW()
   - =DATE

6. Which of the following is not an argument of the IF function?
   - =value_if_true
   - =value_if_false
   - =logical_test
   - =lookup_value

7. Which of the following is not true about the VLOOKUP function?
   - The lookup table must be in ascending order.
   - The lookup table must be in descending order.
   - The default match type is approximate.
   - The match type must be false when completing an exact match.

8. The function =PMT(C5,C7,C5) is stored in cell C15. What must be stored in cell C5?
   - APR
   - Periodic interest rate
   - Loan amount
   - Number of payment periods

9. Which of the following is not an appropriate use of the SUM function?
   - =SUM(B3:B45)
   - =SUM(F1:G10)
   - =SUM(A8:A15,D8:F15)
   - =SUM(D15:C15)

10. What is the keyboard shortcut to create an absolute reference?
    - F2
    - F3
    - F4
    - Alt
Practice Exercises

1 Hamilton Heights Auto Sales

You are the primary loan manager for Hamilton Heights Auto Sales, an auto sales company located in Missouri. In order to most efficiently manage the auto loans your company finances, you have decided to create a spreadsheet to perform several calculations. You will insert the current date, calculate down payment and interest rates based on credit score, calculate periodic payment amounts, and complete the project with basic summary information. Refer to Figure 2.29 as you complete this exercise.

![Image of Hamilton Heights Auto Sales spreadsheet](image)

FIGURE 2.29 Hamilton Heights Auto Sales

a. Open e02p1AutoSales and save it as e02p1AutoSales_LastFirst.

b. Click cell B2, click the Formulas tab, click Date & Time in the Function Library group, select NOW, and then click OK to enter today’s date in the cell.

c. Click cell D5 on the Formulas tab, click Logical in the Function Library group, and select IF.

d. Type =IF(S5<1500) in the Logical_test box, type $D$5*14 in the Value_if_true box, type 0 in the Value_if_false box, and then click OK.

This uses the IF function to calculate the required down payment based on credit score. If the customer has a credit score lower than 750 a down payment is not required. All clients with credits scores lower than 750 must pay a required 10% down payment in advance.

e. Use the fill handle to copy the contents of cell D5 down the column, click Auto Fill Options on the lower-right of the copied cells, and then click Fill Without Formatting to ensure that the Bottom Double border remains applied to cell D10.

f. Calculate the Amount Financed by doing the following:

- Click cell E5 and type =$B$5-$D$5.
- Use cell E5’s fill handle to copy the function down the column.
- Apply Bottom Double border to cell E10.

g. Calculate the Rate by doing the following:

- Click cell F5. Click Lookup & Reference in the Function Library group and select VLOOKUP.
- Type C5 in the Lookup_value box, type SAS14:SBS19 in the Table_array box, type 2 in the Col_index_num box, and then click OK.
- Double-click cell F5’s fill handle to copy the function down the column.
- Click Auto Fill Options, and click Fill Without Formatting.

h. Calculate the required periodic payment by doing the following:

- Click cell G5, click Financial in the Function Library Group, and then click PMT.
- Type $F$5/$SBS17 in the Rate box, type $SBS15 in the Nper box, type –$E5 in the Pv box, and then click OK.
- Double-click cell G5’s fill handle to copy the function down the column.
- Click the Auto Fill Options button, and click Fill Without Formatting.

i. Select the range B5:B10, click the Quick Analysis button, click TOTALS, and select Sum from the Quick Analysis gallery.

j. Click cell E11 and type =AVERAGE(E5:E10) to calculate the average amount financed.

k. Create a footer with your name on the left side, the sheet name code in the center, and the file name on the right side.

l. Save and close the workbook. Based on your instructor’s directions, submit e02p1AutoSales_LastFirst.

2 Lockridge Marketing Analytics

As a business analyst for Lockridge Marketing Analytics, you have been tasked with awarding performance bonuses. You prepare a model to calculate employee bonuses based on average customer satisfaction survey results. The survey is based on a scale of 1 to 5 with 5 being the highest rating. Employers with survey results where ratings are between 1 and 2.9 do not receive bonuses, scores between 3 and 3.9 earn a 2% one-time bonus on their monthly salary, and scores of 4 or higher receive a 5% bonus. In addition, you calculate basic summary data for reporting purposes. Refer to Figure 2.30 as you complete this exercise.

![Image of Lockridge Marketing Analytics spreadsheet](image)

FIGURE 3.30 Lockridge Marketing Analytics

a. Open e02p2Bonus and save it as e02p2Bonus_LastFirst.

b. Click cell B4, click the Formulas tab, click Date & Time in the Function Library group, select TODAY, and then click OK to enter today’s date in the cell.
Mid-Level Exercises

Metropolitan Zoo Gift Shop Weekly Payroll

As manager of the gift shop at the Metropolitan Zoo, you are responsible for managing the weekly payroll. Your assistant developed a partial worksheet, but you need to enter the formulas to calculate the regular pay, overtime pay, gross pay, taxable pay, withholding tax, FICA, and net pay. In addition, you want to include total pay columns and calculate some basic statistics. As you construct formulas, make sure you use absolute and relative cell references correctly in formulas.

a. Open the e02m1Payroll workbook and save it as e02m1Payroll_LastFirst.
b. Study the worksheet structure and read the business rules in the Notes section.
c. Use IF functions to calculate the regular pay and overtime pay based on a regular 40-hour work week in cells E5 and F5. Pay overtime only for overtime hours. Calculate the gross pay based on the regular and overtime pay. Abram's regular pay is $398. With 8 overtime hours, Abram's overtime pay is $119.40.
d. Create a formula in cell H5 to calculate the taxable pay. Multiply the number of dependents by the deduction per dependent and subtract that from the gross pay. With two dependents, Abram's taxable pay is $417.40.
e. Use a VLOOKUP function in cell I5 to identify and calculate the federal withholding tax. With a taxable pay of $417.40, Abram's tax rate is 25% and the withholding tax is $104.35. The VLOOKUP function returns the applicable tax rate, which you must then multiply by the taxable pay.
f. Calculate FICA in cell J5 based on gross pay and the FICA rate, and calculate the net pay in cell K5.
g. Copy all formulas down their respective columns.
h. Use Quick Analysis tools to calculate the total regular pay, overtime pay, gross pay, taxable pay, withholding tax, FICA, and net pay on row 17.
i. Apply Accounting Number Format to the range C5:C16. Apply Accounting Number Format to the first row of monetary data and to the total row. Apply the Comma style to the monetary values for the other employees. Underline the last employee's monetary values and use the Format Cells dialog box to apply Top and Double Bottom borders for the totals.
j. Insert appropriate functions to calculate the average, highest, and lowest values in the Summary Statistics area (the range I21:K23) of the worksheet. Format the # of hours calculations as Number format with one decimal and the remaining calculations with Accounting Number Format.
k. Insert a new sheet named Overtime. List the number of overtime hours for the week. Calculate the yearly gross amount spent on overtime assuming the same number of overtime hours per week. Add another row with only half the overtime hours (using a formula). What is your conclusion and recommendation on overtime? Format this worksheet.
l. Insert a footer with your name on the left side, the sheet name in the center, and the file name code on the right side of both worksheets.
m. Save and close the workbook. Based on your instructor's directions, submit e02m1Payroll_LastFirst.
**Auto Loan Calculator**

As a financial consultant, you work with a family who plans to purchase a $35,000 car. You want to create a worksheet containing variable data (the price of the car, down payment, date of the first payment, and borrower’s credit rating) and constants (sales tax rate, years, and number of payments in one year). Borrowers pay 0.5% sales tax on the purchase price of the vehicle and their credit rating determines the required down payment percentage and APR. Your worksheet needs to perform various calculations.

- a. Start a new Excel workbook. Save it as e02m2Loan_LastFirst, and then rename Sheet1 Payment.
- b. Type Auto Loan Calculator in cell A1, and then merge and center the title on the first row in the range A1:F1. Apply bold, 18 pt font size, and Gold, Accent 4, Darker 25% font color.
- c. Type the labels in the range A3:A12. For each label, such as Negotiated Cost of Vehicle, merge the cells, such as the range A4:B4. Use the Format Painter to copy the formatting to the remaining nine labels. Next type and format the Inputs and Constants values in column C.
- d. Type Credit, Down Payment, and APR in the range A14:C14, type the four credit ratings in the first column, the required down payment percentages in the second column, and the respective APRs in the third column. Next format the percentages, and then indent the percentages in the cells as needed.
- e. Type labels in the Intermediate Calculations and Outputs sections in column E.
- f. Enter formulas in the Intermediate Calculations and Outputs sections to calculate the following:
  - APR based on credit rating: Use a Lookup function that references the borrower’s credit rating and the table array in range. Include the range_lookup argument to ensure an exact match.
  - Minimum down payment required: Use a lookup function and calculation. Use the credit rating as the lookup value, and the table array C5:C18. Include the range_lookup argument to ensure an exact match. Multiply the function results by the negotiated cost of the house.
  - Sales tax: Multiply the negotiated cost of the vehicle by the sales tax rate.
  - Total down payment: The sum of the minimum down payment required and any additional down payment made.
  - Amount of the loan: The difference between the negotiated cost of the house and the total down payment.
  - Monthly payment: Principal and interest using the PMT function.
- g. Format each section with fill color, bold, underline, number formats, borders, and column widths as needed.
- h. Insert a footer with your name on the left side, the sheet name in the center, and the file name code on the right side of both sheets.
- i. Save and close the workbook. Based on your instructor’s directions, submit e02m2Loan_LastFirst.

---

**Facebook and Blackboard**

Social media extends past friendships to organizational and product “fan” pages. Organizations such as Lexus, Pepsi, and universities create pages to provide information about their organizations. Some organizations even provide product details, such as for the Lexus IS350. Facebook includes a wealth of information about Microsoft Office products. People share information, pose questions, and reply with their experiences.

- a. Log in to your Facebook account. If you do not have a Facebook account, sign up for one and add at least two classmates as friends. Search for Microsoft Excel 2016 and click Like.
- b. Review postings on the Microsoft Excel wall. Notice that some people post what they like most about Excel or how much it has improved their productivity. Post a note about one of your favorite features about Excel that you have learned so far or how you have used Excel in other classes or on the job.
- c. Click the Discussions link on the Microsoft Excel Facebook page and find topics that relate to IF or HLOOKUP functions. Post a response to one of the discussions. Take a screenshot of your posting and insert it into a Word document. Save the Word document as e02m3_LastFirst.
- d. Create a team of three students. Create one discussion that asks people to describe their favorite use of any of the nested functions used in this chapter. Each team member should respond to the posting. Monitor the discussion and, when you have a few responses, capture a screenshot of the dialogue and insert it into your Word document.
- e. Go to www.youtube.com and search for one of these Excel topics: absolute references, mixed references, semi-selection, IF function, VLOOKUP function, or PMT function.
- f. Watch several video clips and find one of particular interest to you.
- g. Post the URL on your Facebook wall. Specify the topic and describe why you like this particular video.
- h. Watch videos from the links posted by other students on their Facebook walls. Comment on at least two submissions. Point out what you like about the video or any suggestions you have for improvement.
- i. Insert screenshots of your postings in a Word document, if required by your instructor. Save and close the file. Based on your instructor’s directions submit e02m3_LastFirst.
Beyond the Classroom

Auto Finance

After graduating from college and obtaining your first job, you have decided to purchase a new vehicle. Before purchasing the car, you want to create a worksheet to estimate the monthly payment based on the purchase price, APR, down payment, and years. Your monthly budget is $500 and you will use conditional logic to automatically determine if you can afford the cars you are evaluating. Open the workbook e02b1CarLoan and save it as e02b1CarLoan_LastFirst.

Insert a function to automatically enter the current date in cell A4. Starting in cell B12 enter a formula to calculate the down payment for each vehicle price range based on the down payment percentage listed in cell D4. Be sure to use the appropriate absolute or mixed reference and copy the formula to complete range B13:B16. Before calculating the periodic payment for each vehicle, you will need to research the current vehicle interest rates. Conduct an Internet search to determine the current interest rate for a five-year auto loan and enter the value in cell D5. In cell C12 type a function that calculates the periodic payment for the first vehicle based on the input information in range D4:D7. Be sure to use the appropriate absolute or mixed reference and copy the formula to complete range C12:C16. In column D, use an IF function to determine if the first vehicle is financially viable; display either Test Drive or NA based on the criteria in cell D8. Be sure to use the appropriate absolute or mixed reference and copy the formula to complete range D12:D16.

Include a footer with your name on the left side, the date in the center, and the file name on the right side. Save and close the workbook. Based on your instructor's directions, submit e02b1CarLoan_LastFirst.

Park City Condo Rental

You and some friends are planning a Labor Day vacation to Park City, Utah. You have secured a four-day condominium that costs $1,200. Some people will stay all four days; others will stay part of the weekend. One of your friends constructed a worksheet to help calculate each person's cost of the rental. The people who stay Thursday night will split the cost evenly. Everyone agreed to pay $30 per night per person for Friday, Saturday, and/or Sunday nights. Depending on the number of people who stay each night, the group may owe more money. Kyle, Ian, Isaac, and Daryl agreed to split the difference in the total rental cost and the amount the group members paid. Open the workbook e02b2ParkCity, and save it as e02b2ParkCity_LastFirst.

Review the worksheet structure, including the assumptions and calculations notes at the bottom of the worksheet. Check the formulas and functions, making necessary corrections. With the existing data, the number of people staying each night is 5, 8, 10, and 7, respectively. The total paid given the above assumptions is $1,110, giving a difference of $90 to be divided evenly among the first four people. Kyle’s share should be $172.50. In the cells containing errors, insert comments to describe the error and fix the formulas. Verify the accuracy of formulas by entering a function in cell E11 to ensure that the totals match. Nick, James, and Body inform you they cannot stay Sunday night, and Rob wants to stay Friday night. Change the input accordingly. The updated total paid is now $1,200, and the difference is $150. Include a footer with your name on the left side, the date in the center, and the file name on the right side. Save and close the workbook. Based on your instructor's directions, submit e02b2ParkCity_LastFirst.

Capstone Exercise

You are an account manager for Inland Jewelers, a regional company that makes custom class rings for graduating seniors. Your supervisor requested a workbook to report on new accounts created on payment plans. The report should provide details on total costs to the student as well as payment information. Each ring financed has a base price that can fluctuate based on ring personalization.

Insert Current Date
You open the starting workbook you previously created, and insert the current date and time.

Calculate the Monthly Payment
Your next step is to calculate the periodic payment for each student's account. The payments are based on the years financed in column F and the annual interest rate in cell B22. All accounts are paid on a monthly basis.

Finalize the Workbook
You perform some basic statistical calculations and finalize the workbook with formatting and page setup options.
Excel

Datasets and Tables

LEARNING OUTCOME
You will demonstrate how to manage and analyze large sets of data.

OBJECTIVES & SKILLS: After you read this chapter, you will be able to:

Large Datasets

OBJECTIVE 1: FREEZE ROWS AND COLUMNS 265
Freeze Rows and Columns

OBJECTIVE 2: PRINT LARGE DATASETS 266
Display and Change Page Breaks, Set and Clear a Print Area, Print Titles, Control Print Page Order

HANDS-ON EXERCISE 1:
Large Datasets 270

Excel Tables

OBJECTIVE 3: UNDERSTAND THE BENEFITS OF DATA TABLES 275
Understand the Benefits of Data Tables

OBJECTIVE 4: DESIGN AND CREATE TABLES 275
Create a Table; Rename a Table; Add and Delete Fields; Add, Edit, and Delete Records; Remove Duplicate Rows

HANDS-ON EXERCISE 2:
Excel Tables 282

Table Manipulation

OBJECTIVE 5: APPLY A TABLE STYLE 280
Apply a Table Style

HANDS-ON EXERCISE 3:
Table Manipulation 295

Table Aggregation and Conditional Formatting

OBJECTIVE 6: CREATE STRUCTURED REFERENCES IN FORMULAS 287
Create a Structured Reference in a Formula

OBJECTIVE 7: SORT DATA 288
Sort One Field, Sort Multiple Fields, Create a Custom Sort

HANDS-ON EXERCISE 3:
Table Manipulation 295

OBJECTIVE 8: FILTER DATA 290
Apply Text Filters, Apply Number Filters, Apply Date Filters, Apply a Custom Filter

HANDS-ON EXERCISE 4:
Table Aggregation and Conditional Formatting 312

CASE STUDY | Reid Furniture Store

Vicki Reid owns Reid Furniture Store in Portland, Oregon. She divided her store into four departments: Living Room, Bedroom, Dining Room, and Appliances. All merchandise is categorized into one of these four departments for inventory records and sales. Vicki has four sales representatives: Chantalle Desmarais, Jade Gallager, Sebastian Gruenewald, and Ambrose Sardelis. The sales system tracks which sales representative processed each transaction.

The business has grown rapidly, and Vicki hired you to analyze the sales data in order to increase future profits. For example, which department generates the most sales? Who is the leading salesperson? Do most customers purchase or finance? Are sales promotions necessary to promote business, or will customers pay the full price?

You downloaded March 2018 data from the sales system into an Excel workbook. To avoid extraneous data that is not needed in the analysis, you did not include customer names, accounts, or specific product numbers. The downloaded file contains transaction numbers, dates, sales representative names, departments, general merchandise descriptions, payment types, transaction types, and the total price.

FIGURE 4.1 Reid Furniture Store Datasets

CASE STUDY | Reid Furniture Store

Starting File File to be Submitted

e04h1Reid e04h4Reid_LastFirst